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IBM Lotus Sametime 7.5 Release Notes	 About this release 

Chapter 1 - About this release


New in this release 

New features in IBM Lotus Sametime Connect  7.5 Client 
The new IBM Lotus Sametime Connect 7.5 client is a significant upgrade to the Sametime Connect 
desktop client provided with previous Sametime releases.  The new Lotus Sametime Connect client is 
based on Eclipse technology, and includes the features listed below. 

Instant Messaging 

Log-in 

z	 Set awareness state and message at log-in 

z	 Support multiple Sametime communities from a single client 

Instant Contacts 

z	 "Business card" view of contact information, including location, phone, and local time 

z	 Display Bubble Alerts that notify you when a contact comes online, becomes available, or goes 
offline, or when you receive a new chat message 

z	 Support for user pictures and summaries 

z	 Support for locations 

z	 Nested groups 

z	 New "In A Meeting" status, with less intrusive IM behavior 

z	 Chat without adding someone to your buddy list 

z	 Quick Find feature, to quickly find contacts in your contact list by typing the first few characters of 
the name 

z	 Switching of user interface language from the preferences page to any one of 22 languages 

Chat window 

z	 Optionally display time stamps for each message in a chat window 

z	 Support for rich text and emotive icons 

z	 Change your online status, or see your partner's on-line status, from the chat window 

z	 Configure the Enter key to insert a carriage return instead of sending the message 

z	 Spell check while typing 

z	 A "Send e-mail" feature 

z	 A click-to-talk feature, using embedded VoIP 

1 



IBM Lotus Sametime 7.5 Release Notes	 About this release 

z	 A click-to-dial feature embedded in the chat window, when a Telephony extension is installed with 
the Sametime server 

z	 Print from the chat window 

z	 See a message when a chat partner leaves a chat 

z	 Instant image screen capture 

z	 Send images and text combined in the same Send line 

Chat history 

z	 Users have the option to automatically, manually, or not save a chat 

z	 Chat history is saved locally, and chat transcripts can be retrieved from a new "Inbox"-style UI 

Extensibility 

z	 Please see the available Lotus Sametime 7.5 Software Development Kit for additional information 
about client extensibility 

Contact list overview 
The format of the contact list is new for Sametime7.5, and the list is stored in a location on the server 
seperate from the previous version of the contact list used by older clients.  The first time a user logs into 
a Sametime server with Sametime 7.5, if the user has a "classic" contact list from an older client, it is 
retrieved and converted into the Sametime 7.5 format.  From this point forward, the user can re-import the 
classic contact list at any time, by using the 'Import Contact List From Server' option located in the "File" 
menu; this always imports the classic contact list, not the Sametime 7.5 contact list.  Note that the 
Sametime 7.5 contact list need not be imported since it is pulled from the server automatically each time 
the user logs in. 

Remote and local contact list 
The contact list is stored in an XML format both locally on the client machine and remotely on the server; 
the two copies are kept in synch with each other.  When the client is launched, the local contact list is 
parsed.  After the user logs in, the remote contact list is retrieved and the timestamps of the local and 
remote lists are compared. If the server list is found to be more recent than the local list, a dialog allows 
the user to keep the local list, replace the local list with the remote copy, or merge the two together. 

The local contact list is located in a file in the user workspace.  A typical location of the file on a Windows 
machine is: 
<user.home>/Application 
Data/Sametime/.metadata/.plugins/com.ibm.collaboration.realtime.imhub/buddylist.xml 

Saving and exporting the contact list 
The contact list is saved automatically in response to contact list activity.  Creation, deletion, and update 
events performed on users or groups in the contact list trigger a save of the contact list, both locally and 
remotely. 

The contact list can be exported manually to a file in the Sametime 7.5 format by selecting the File menu 
option 'Export Contact List To Sametime 7.5 file'. 

The contact list can also be exported into the classic contact list format by selecting the File menu option 
'Export Contact List to Community File'.  The export processes only users and public groups that pertain 
to the selected community, since previous version of the contact list support only a single community.  
The exported ".dat" file can then be imported by previous Sametime clients. 
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Spell checker overview 
The Sametime 7.5 spell checker provides spell checking functionality for 12 languages.  The dictionaries 
are part of the server installation, and are found on CD 4, in a directory called "SpellCheckerDictionaries"; 
there are plugin and features for each dictionary. 

By default, the client comes with the US English dictionary installed.  Administrators can create a site that 
will allow users to install dictionaries as a feature, or a user can just copy the plugin folder for the 
dictionary to the plugin folder of their Sametime client.  The spell checker will default to English for 
languages it does not support. 

Supported languages in this release 

01 - com.ibm.langware.v5.dic.fi_FI (Finish - Finland) 
02 - com.ibm.langware.v5.dic.fr_FR (French) 
03 - com.ibm.langware.v5.dic.de_DE_Reform (German) 
04 - com.ibm.langware.v5.dic.el_GR (Greek) 
05 - com.ibm.langware.v5.dic.it_IT (Italian) 
06 - com.ibm.langware.v5.dic.nb_NO (Norwegian Bokmal) 
07 - com.ibm.langware.v5.dic.pl_PL (Polish) 
08 - com.ibm.langware.v5.dic.pt_PT (Portuguese - Portugal) 
09 - com.ibm.langware.v5.dic.pt_BR (Portuguese - Brazil) 
10- com.ibm.langware.v5.dic.ru_RU (Russian) 
11- com.ibm.langware.v5.dic.es_ES (Spanish) 
12- com.ibm.langware.v5.dic.sv_SE (Swedish) 

Unsupported languages in this release 
1 - Hungarian 
2 - Turkish 
3 - Japanese 
4 - Korean 
5 - Simplified Chinese 
6 - Traditional Chinese 

Macintosh support is Extended Beta only 
The Sametime Connect 7.5 client is supported as an Extended Beta release on the Macintosh platform.  
The Extended Beta is a pre-production release of software; it allows you to continue using these 
technologies and provide feedback. References to the Macintosh platform within the product 
documentation, and in these release notes, should be understood in the context of the Extended Beta 
release; Macintosh is not a fully supported platform for Sametime 7.5 at this time. 

New features in IBM Lotus Sametime  7.5 Meeting Room Client 
The new IBM Lotus Sametime 7.5 Meeting Room client includes the features listed below. 

Web conferencing 

z	 Simplified meeting creation. 

z	 Welcome screen shows on meeting entry, giving users pertinent information when they join the

meeting.


z	 New Slides tab enables easier management of presentation files 

z	 Ability for any presenter to upload slides during a meeting 
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z	 Improved slide conversion and scaling 

z	 Improved annotation tools, for both slides and the Whiteboard, including: editable text,

highlighter/laser pointer tools, and easier line width/color controls


z	 Simplified screen sharing interface 

z	 "Now Sharing" icon displays next to user who is sharing their screen, so you can easily identify

whose screen is being shared.


z	 Easier permissions handling, plus defaults to easily make everyone able to present 

z	 Indicator when new group chat message is entered 

z	 Improved telephony controls, including controls that let users mute and unmute their own lines 

z	 Ability to enter polling questions before sending them out 

z	 Options to sort and filter the participant list (e.g., show only presenters, sort by entry time, sort by 

order of hand raise)


z	 Improved connectivity, with improvements in user experience, pop-up coexistence, and connection 
resilience, specifically: 

Meeting Room Client 

- Client starts first, and then establishes a connection 

- If connection is lost, the client stays open and tries to re-establish a connection 

- Icons in the status bar indicate the connection status 

- Pop-up messages inform users of actions to take


Pop-ups


- Many pop-ups eliminated 

- Users receive feedback when pop-up blockers are invoked


Connectivity


- Fall-back options (TCP automatically falls back to HTTP) 

- Persistent connection not required 

Meeting and Client Help documentation 
Help documentation is available from both the Sametime Meeting and Sametime Connect clients.  Click 
Help - Help Topics to display the Help in either client.  Note that the contents of both Help systems are not 
yet final, and may not always reflect the current product implementation. 

Release notes: Updated information available on-line 
The Release Notes that are available on-line are more up-to-date than the Release Notes that are 
shipped with this product.  This is due to production schedules; after the product ships, updates are 
sometimes made to the Release Notes and posted on the Lotus developerWorks website. 

To ensure that you have the very latest version of the Sametime Release Notes, please visit the Lotus 
Documentation page at: 

http://www.lotus.com/ldd/doc 
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Chapter 2 - Installation, migration, upgrade, and 
configuration information 

Hardware requirements 

Hardware requirements for Sametime  7.5

Server requirements


Sametime requires one server for Sametime installation that meets these requirements: 

Operating System - IBM eServer pSeries (AIX) 

z	 CPU -- Dual 475 MHz, or higher, IBM PowerPC processor recommended; Dual 375 MHz PowerPC 
processor minimum. 

z	 Memory -- 2 GB recommended; 1 GB minimum. 

z	 Disk space -- 3 GB free disk space recommended to allow space for meetings; 2 GB minimum. 

z	 Disk swap space -- 2 GB RAM recommended. 

z	 Video requirements -- Video card installed.  Recommended video display color setting is 16-bit color.  
The setting must be higher than 256 colors. 

Operating system - i5/OS 

z	 IBM i5/OS, 5722SS1, Version 5 Release 3 or later. For more details, see "Installing and Managing 
Lotus Sametime 7.5 for i5/OS" (stinstall.nsf). 

TM TM	 TM
z	 CPU -- IBM eServer iSeries , IBM eServer  i5, or IBM System i5  server models capable of running 

IBM i5/OS V5R3 

z	 Memory -- Minimum 1GB for each Sametime and Domino server 

z	 Disk space -- Minimum 500MB free disk space, 1GB recommended; minimum of 4 Disk Drives (arms) 

Operating system - Sun Solaris 

z	 CPU -- UltraSPARC III 1 GHz processor, or higher recommended; UltraSPARC III 550 MHz 
processor minimum 

z	 Memory -- 2 GB recommended; 1 GB minimum. 

z	 Disk space -- 3 GB free disk space recommended to allow space for meetings; 2 GB minimum. 

z	 Disk swap space -- 2 GB RAM recommended. 

z	 Video requirements -- Video card installed.  Recommended video display color setting is 16-bit color.  
The setting must be higher than 256 colors. 
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Operating system - Microsoft Windows 

z	 CPU -- Intel Pentium III 800 MHz, or higher, recommended. 

z	 Memory -- 2 GB recommended; 1 GB minimum. 

z	 Disk space -- 1 GB free disk space recommended to allow space for meetings; 500 MB minimum. 

z	 Disk swap space -- 1.5 GB RAM recommended; 1GB minimum Network software.  TCP/IP network 
software installed. 

z	 Video requirements -- Video card installed.  Recommended video display color setting is 16-bit color.  
The setting must be higher than 256 colors. 

Client requirements 

The client system requirements for operation with the Sametime 7.5 server (and Multimedia Services) 

include:


z	 CPU -- Pentium II 266 MHz (or higher). 

z	 RAM -- 128 MB RAM or higher. 

Software requirements 

IBM Lotus Sametime Connect  7.5 client software requirements

The IBM Lotus Sametime Connect 7.5 client is a completely new implementation of the Sametime

Connect client, using Java (TM) and Eclipse technology.  Following are the software requirements and

support statements for the Sametime Connect 7.5 client:


Sametime Connect Client 

Platforms supported 

z	 Windows XP Professional (Service Pack 1) 

z	 RedHat Enterprise Linux 4.0 

z	 Novell Linux Desktop 9.0 

z	 Mac OS X 10.4 

Note: The Sametime Connect client is not supported on Windows 2000, and has not been tested on this

platform.  We are aware, however, that users have been able to run the client successfully on this

platform. 
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IBM Lotus Sametime 7.5 Meeting Room client requirements 
Following are the software requirements and support statements for the Sametime 7.5 Meeting Room 
client: 

Meeting Room Client 

Browsers supported 

z	 Internet Explorer 6.0 on Windows XP Professional 

z	 Mozilla 1.7.12 on Windows  XP Professional 

z	 Mozilla 1.7.6 on RedHat Enterprise Linux 4.0 or Novell Linux Desktop 9.0 

z	 Firefox 1.5 on Windows XP Professional, RedHat Enterprise Linux 4.0, and Novell Linux Desktop 
9.0 

Java JDK/JRE supported 

z	 IBM or Sun JDK/JRE 1.4.2 or later - Internet Explorer 6.0 on Windows XP Professional 

z	 IBM or Sun JRE 1.4.2 or later - RedHat Enterprise Linux 4.0 and Novell Linux Desktop 9.0 

IBM Lotus Sametime 7.5 server software requirements 
Following are the software requirements and support statements for the Sametime 7.5 server: 

Operating Systems 

z	 AIX 5.3; AIX 5.2 - The installation program will run from an XWindows interface.  Administrators 
also have the option to use a text-based console install version; the console install will run from a 
telnet session or equivalent. Full administration privileges are required on unix:  must be root. 

Note: AIX 5.2 - requires patch level 2 (5200-02). 

z	 Solaris 10 (SPARC); Solaris 9 (SPARC) - The installation program will run from an XWindows 
interface. Administrators also have the option to use a text-based console install version; the 
console install will run from a telnet session or equivalent.  Full administration privileges are 
required on unix: must be root. 

z	 Windows 2000 Advanced Server (Service Pack 4) 

z	 Windows 2003 Advanced Edition 

z	 IBM i5/OS, 5722SS1, Version 5 Release 3 or later. For more details, see "Installing and

Managing Lotus Sametime 7.5 for i5/OS" (stinstall.nsf).


Notes: 

z	 On Windows, you must have full administration rights to install Sametime; if not, Sametime will 
not install properly.  In addition, please note that only Microsoft TCP/IP is supported for Windows. 

z	 On UNIX, you must install as root; if not, Sametime will not install properly. 

z	 The video display color setting on the Sametime server must be higher than 256 colors.  The 
recommended video display color setting is 16-bit color. 

z	 AIX and Solaris no longer require an X11 interface.  Administrators have an option to use the 
text-based console install version as well.  The console install will run from a telnet session or 
equivalent. 
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LDAP directories 

z IDS 5.1 and 5.2 

z Domino 6.5 and 7.0 

z Microsoft Active Directory 2003 

z Sun ONE Directory 5 (iPlanet 5.1 and 5.2) 

Supported Domino server version 

Sametime 7.5 must install on a Domino 7.0 or later server.  Note that the Domino 7.x server release must 
be installed prior to installing the Sametime server. 

Installation notes 

Installing the IBM Lotus Sametime Connect  7.5 client 
If your administrator installed the IBM Lotus Sametime Connect 7.5 client files on your Sametime 7.5 
server, you can download the client files from that server. If you have access to the IBM download site, 
you can also download the client files from there. 

Downloading Sametime Connect  7.5 for Windows or Linux 
To download the Sametime Connect 7.5 client files for Windows or Linux from your server, follow the 
instructions below. These instructions will not work for the Macintosh version of the client, so you'll need 
to follow the Macintosh instructions instead. 

1.	 Using a web browser, open the Sametime Center page (stcenter.nsf) on your Sametime 7.5 server. 
For example, if your Sametime 7.5 server host name is st75server.com, you would open 
http://st75server.com/stcenter.nsf. 

2.	 Select the link to the download the Lotus Sametime Connect 7.5 Client to display the download page. 

3.	 Select the Sametime Connect 7.5 download link for either Windows or Linux to download the client 
install package to your local drive. 

4.	 Follow the instructions below to install the Sametime Connect client (these instructions are also on the 
download page). 

5.	 The first time you launch the client, you'll need to enter the host name of your Sametime server. Use 
the name of the server from which you downloaded the files, unless your administrator has instructed 
you to use a different server. 
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Downloading Sametime Connect  7.5 for Macintosh 
To download the Sametime Connect 7.5 client files for Macintosh from your server, follow the instructions 
below: 

1.	 Using a web browser, launch the URL 
http://<hostname>/sametime/sametimeclient/sametime-connect-mac-7.5.0.comman 
d, where <hostname> is the host name of your Sametime 7.5 server, for example, 
st75server.com. 

2.	 Save the client install package to your local drive. 

3.	 Follow the instructions below to install the Sametime Connect client. 

4.	 The first time you launch the client, you'll need to enter the host name of your Sametime server. Use 
the name of the server from which you downloaded the files, unless your administrator has instructed 
you to use a different server. 

Installing Sametime Connect  7.5 for Windows 
Launch the install program (sametime-connect-win-7.5.0.exe) to begin the installation. You will be 
prompted for required information. The install program will create a Sametime Connect icon on your 
Windows desktop. 

To uninstall Sametime Connect, use the Windows Add-Remove Programs utility. 

Installing Sametime Connect  7.5 for Macintosh 

1.	 Launch the install program (sametime-connect-mac-7.5.0.command) to extract the Sametime 
Connect application .dmg file to a directory of your choice. 

2.	 Launch the .dmg file to create a virtual drive on the Desktop. 
3.	 Open the virtual drive and drag the Sametime folder from there to your Applications folder. 
4.	 Go to the new copy of the Sametime folder and launch the Sametime application. 

To uninstall Sametime Connect, browse to your Applications folder, locate the Sametime application 
folder and drag it to the trash 

Installing Sametime Connect  7.5 for Linux 

1. As a superuser (for example. while logged in as root), run the install program using the following 
command: 

rpm -i sametime-connect-lin-7.5.0-1.i386.rpm 

2. Launch Sametime using the following command: 

/usr/bin/sametime 

To uninstall Sametime Connect, use the following command, as a superuser: 

rpm -e sametime-connect-lin-7.5.0-1 
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Additional installation steps for administrators 
After you complete the installation of the IBM Lotus Sametime 7.5 Server release, you will need to copy 
the Sametime Connect 7.5 client installation files to the Sametime server.  End users will be unable to 
download and install the client files until you perform this task. 

The client installation files are posted on the IBM download site. There are 3 files, one for each client 
platform: 

Windows: sametime-connect-win-7.5.0.exe 
Macintosh: sametime-connect-mac-7.5.0.command 
Linux: sametime-connect-lin-7.5.0-1.i386.rpm 

Download all of these files from the download site, and place them in the 
<datadir>\domino\html\sametime\sametimeclient directory on the Sametime server. The 
default locations are shown below. There may already be files with these names in that directory -- these 
are placeholder files that you must replace with the real ones. 

For Windows: 

c:\program files\lotus\domino\data\domino\html\sametime\sametimeclient 

For AIX/Solaris: 

/local/notesdata/domino/html/sametime/sametimeclient 

For i5/OS: 

There is no default data directory but the name may be similar to this: 

/STserver/domino/html/sametime/sametimeclient 

After copying the file, run the following command from any i5/OS command line to change the owner 
of all of the copied objects to QNOTES: 

CHGOWN OBJ('server_data_directory/domino/html/sametime/sametimeclient/*') 
NEWOWN(QNOTES) 

To verify that you've copied the files correctly, go to the Sametime Center web page on your server, and 
follow the download links to download the client files for all platforms. 

Note: The Sametime Center download page does not include a download link for the Macintosh version of 
the client installation file.  End users will need to download the Macintosh version of the client installation 
file using the following URL: 

http://<hostname>/sametime/sametimeclient/sametime-connect-mac-7.5.0.command 

where <hostname> is the host name of your Sametime 7.5 server. 
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Install Linux libraries for Meeting Room Client  (MRC) 
For the Meeting Room Client (MRC) installation on Linux, libraries are available.  Sametime 7.5 supports 
two Linux platforms for clients: RedHat and SuSE; you can install all the libraries required for the 
Sametime native code through the RedHat/SuSE standard installers.  

SuSE 
Go to the SuSE main menu -> System -> YaST2 -> Install and Remove Software.  Then, install these 
package groups: 

1. Graphical Base System 
2. GNOME system 
3. Office Applications 
4. C/C++ Compiler Tools 

RedHat 
Go to the RedHat menu -> System Settings -> Add/Remove Applications.  Then, install these package 
groups: 

1. X Windows System 
2. GNOME Desktop Environment 
3. GNOME Software Development 
4. Legacy Software Development 

Installing Sametime Conversion Services with AIX, Solaris, i 5/OS 
Sametime Conversion Services is a feature that takes files of various formats (slides, images, documents, 
etc.) and provides a bitmap rendering, so they can be shared in a meeting as slides.  Sametime 
Conversion Services has been enhanced for Sametime 7.5 to use new conversion technologies that 
provide more faithful rendering of slides.  The same technology is used for all Sametime servers, 
regardless of the platform used for your Sametime server. 

In order to utilize this function for AIX, Solaris, and i5/OS Sametime servers, you must install Sametime 
Conversion Services on a Windows system from the Sametime Components CD. The Sametime server 
must also be configured to connect to the Windows system. 

When you install Sametime 7.5 on AIX or Solaris, you are prompted to provide connection information for 
the system where you plan to run conversion services. 

For i5/OS, connection information parameters have been added to the command for adding Sametime to 
a Domino server (ADDLSTDOM). 

If you prefer, you can manually configure the conversion services information at a later time. 

Detailed information about setting up Sametime 7.5 Conversion Services are included in the Meeting 
Services section of the Lotus Sametime 7.5 Administrator's Guide, rather than in a separate guide, as in 
previous releases. 
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Installing the Lotus Sametime 7.5 Software Development Kit 
For Sametime 7.5, all of the Sametime toolkits are available in the Lotus Sametime 7.5 Software 
Development Kit (SDK). The Sametime SDK includes the following toolkits: 

z	 Sametime Connect Toolkit  * 
z	 Sametime Links Toolkit 
z	 Sametime Java Toolkit 
z	 Sametime Telephony Conferencing Service Provider Interface (TCSPI) Toolkit 
z	 Sametime Community Server Toolkit 
z Sametime Directory and Database Access Toolkit

z Sametime Monitoring and Statistics Toolkit  *

z Online Meeting Toolkit  *


* new for 7.5 

The Sametime toolkits for 7.5 and beyond will only be available in the Sametime SDK, not individually. 
You can download the Lotus Sametime 7.5 SDK, and previous Sametime toolkit releases, by using the 
"Lotus Sametime 7.5 SDK" link on the Sametime server home page, or by going to the following IBM 
developerWorks site: 

http://www.ibm.com/developerworks/lotus/downloads/toolkits.html 

The Sametime SDK is packaged in a .zip archive file. To install the SDK, simply extract the contents of 
this file to any location on your local drive. After extracting the files, see the file readme.txt in the 
st75sdk directory for important information about the SDK.  To uninstall the SDK, simply delete the 
st75sdk directory. 

Note: The Sametime C++ Toolkit and COM Toolkit were not updated for the Sametime 7.5 release, and 
are not included in the Sametime 7.5 SDK. The previous releases of these toolkits are still available on 
the developerWorks site, and should work with the Sametime 7.5 release, but there are no plans to further 
enhance these toolkits. 

Upgrade notes 

Conversion Services upgrade required for AIX, Solaris, i 5/OS 
If you have been using Sametime Conversion Services with your current release of Sametime, there are 
several changes for Sametime 7.5 that you need to be aware of. Significant impacts to the upgrade 
process are highlighted below, but you should consult the Meeting Services section of the Lotus 
Sametime 7.5 Administrator's Guide for detailed information (there is no separate Sametime Conversion 
Services Setup Guide for Sametime 7.5; all of the installation and configuration information is now 
included in the Administrator's Guide). 

z	 The requirements for the Windows system where you run the conversion services have changed.  
Make sure the system you are planning to use satisfies the requirements for 7.5. (This system is 
referred to as the Conversion Server.) 

z	 You must uninstall the version of Sametime Conversion Services you are currently using, and 
then install the 7.5 version from the Sametime Components CD. The new version may be 
installed as a standalone Windows service, but Sametime 7.5 also provides the option to 
configure a Domino server on the Windows system and then install the conversion services as a 
Domino servlet. 
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z	 Sametime 7.5 Conversion Services is not compatible with previous versions of Sametime. If you 
have multiple Sametime servers sharing the same Conversion Server, they can also share a 
single Sametime 7.5 Conversion Server once you have upgraded all of them to Sametime 7.5. If 
you do not plan to upgrade all of the servers at the same time, you will need at least two 
Conversion Servers: one for the Sametime 7.5 servers and a separate one for the Sametime 
servers that have not yet been upgraded. 

z	 Sametime 7.5 no longer stores the connection information for the Conversion Server in the 
meetingserver.ini file. The connection information is now stored in the stconvservices .properties 
file, located in the server data directory. If the IP address or port for the Conversion Server ever 
changes, you must update this file. Note that if you install the conversion services as a Domino 
servlet, then reconfiguring Domino HTTP on the Conversion Server to use a different IP address 
or port affects the conversion services connection and you will need to update 
stconvservices .properties. 

z	 When you upgrade Sametime on AIX or Solaris, you will be prompted to provide connection 
information for the system where you plan to run conversion services. If you prefer, you can 
manually configure the conversion services information at a later time. 

z	 When you install Sametime 7.5 on i5/OS, existing Sametime servers are upgraded and the 
conversion server IP address and port number that were previously stored in the 
meetingserver.ini file are migrated to stconvservices .properties. After upgrading, you must 
update this file if the IP address or port for your Conversion Server are different from the previous 
release. 

Maintaining SIP support after upgrading to ST 7.5 
Sametime 7.5 is planned to support communication with other communities through the RTC Gateway, 
that replaces the SIP Gateway.  Until the RTC Gateway is released, customers who want to continue 
using SIP to communicate with other communities should follow the steps in technote #1244026 before 
upgrading their server to Sametime 7.5: 

http://www.ibm.com/developerworks/lotus/support/ 

Please also see "Real-Time Collaboration Gateway replaces Sametime SIP Gateway" in these release 
notes for additional information 

Migrating privacy data after upgrading server 
If your users have stored privacy information ("Who can see me") from your earlier release of Sametime, 
then you need to migrate this information by running a utility after upgrading to Sametime 7.5.  Privacy 
information from the earlier release will not be used unless it is migrated.  For more information, see 
technote 1242317 "Migrating privacy data after upgrading to Sametime 7.5."  This technote is available at: 

http://www.ibm.com/support/docview.wss?rs=203&uid=swg21242317 
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Configuration notes 

Launching and configuring the Sametime Connect  7.5 client 
After you install the Lotus Sametime Connect 7.5 client, you can launch the client and complete the 
configuration as follows: 

1.	 If you wish to create a shortcut to the Sametime Connect client on your windows desktop, create one 
pointing to sametime.exe in the Sametime folder you installed the client to. 

2.	 Launch the client by running sametime.exe (Windows) or ./sametime (Linux) in the sametime 
directory that was created when you extracted the files. 

The first time you launch the client, you will need to enter the host name of your Sametime server. 
This could be a ST 7.5 server or a pre-7.5 Sametime server. See the known limitations section for a 
list of the features that will not be available in the client if you connect to a pre-7.5 Sametime server. 

The Sametime Connect 7.5 client supports login to multiple Sametime communities from a single 
client instance. You primary Sametime community is defined as the Sametime server you provide 
initially in the login window. Your primary server is where your contact list that holds users from 
multiple communities will actually be stored. In addition, the password to the primary community is the 
password you will use to "login" to the client each time you launch it. If you choose to define additional 
Sametime communities, you can select to have their password stored and to be logged in 
automatically to them, simply by logging in to your primary Sametime community. See instructions 
below for how to add additional Sametime communities. You can change your primary community by 
clicking the "Reset User" button on the Login dialog. 

Use the name of the server from which you downloaded the files, unless your administrator has 
instructed you to use a different server. 

3.	 After entering your primary community Sametime server in the host field, enter your user name and 
password for that community and click the Login button. 

4.	 After connecting to your Sametime server, your Contacts list will appear.  If you are connecting to a 
Sametime server that you have used before, you will see your existing Contacts list.  If you are 
connecting to this Sametime server for the first time, you will see a Contacts list with a group called 
"Work" containing your name. (Note: If you already have a Contacts list on this server, the Sametime 
Connect 7.5 client will make a new copy of your Contacts list.  Any changes you make to your 
Contacts list using the Sametime Connect 7.5 client will not be visible to older Sametime client 
releases). 

5.	 To add a new Contact or Group to your Contacts list, select File -> New -> Contact or Group. 

6.	 To add a new Community, select File -> New -> Community. Since we only support Sametime 
communities in this release, click Next in the dialog that shows up. In the next dialog enter the 
community information and select any options you would like.  Once the community is added, you will 
see additional icons at the top left of the main client window. By clicking on these community icons 
you can login/logout, change status and do other actions on each community. 

The next time you launch the Sametime Connect 7.5 client, the Login to Sametime window appears.  

Enter the password you specified in step 2 above, then click Login to connect to the server.  If you 

later decide to change either your logon password or any information you entered on the Login

Information screen (step 3 above), use the Reset User button on the Login to Sametime window.  

This will discard all of the information you have entered, and will start the configuration process again,

as if you are launching the Sametime Connect 7.5 client for the first time, allowing you to change your

primary community. Note that Reset User does not affect your Contacts list in this release.
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Sametime 7.5 Reverse Proxy configuration 
In the Sametime Administrator's Guide, Configuring Ports and Network Connectivity (chapter 5), the 
feature to enable reverse proxy discovery on the client is not functional.  This feature enables clients to 
connect to a Sametime server through a reverse proxy server.  Corporate intranet users who are not 
required to route connections through the reverse proxy can still establish connections with the Sametime 
server.  

Capability to enable reverse proxy discovery on the client enhances the existing logic in Sametime clients 
by adding the reverse proxy connection logic to existing logic which is still present and operable in the 
client.  The Sametime Connect for browsers client includes a "Host name" and "Port" setting in the 
Options-Preferences-Sametime Connectivity tab. The values in these settings are ignored when the 
Sametime server is configured to operate with a reverse proxy server. (In a normal Sametime 
deployment, these settings specify the Host name of the Sametime server to which the client should 
connect and the port number on which the Sametime server listens for connections from Sametime 
Connect clients). 

1.	 Configure ST server to Enable Reverse Proxy Discovery on the client and set server alias; then 
restart server. 

2.	 Configure Apache reverse proxy Rules are added to config file like these: 

ProxyPass  /sun2/communityCBR/

ProxyPass  /sun2/CommunityCBR/

ProxyPass  /sun2/MeetingCBR

ProxyPass  /sun2/BroadcastCBR

ProxyPass  /sun2/


http://sun2.lotus.com:8082/communityCBR/ 
http://sun2.lotus.com:8082/CommunityCBR/ 
http://sun2.lotus.com:8081/MeetingCBR 
http://sun2.lotus.com:554/BroadcastCBR 
http://sun2.lotus.com/ 

3.	 On the client, open browser and input URL: http://cdl-proxy3.lotus.com:80/sun2/stcenter.nsf 

4.	 Click the Administer the Server link. 

5.	 Page will not display. 

Configuring Sametime to work behind WebSEAL reverse proxy

The administrator's guide contains a "Using reverse proxy or portal servers with the Sametime server" 

that discusses using Sametime with reverse proxy servers.


If you are deploying Sametime behind a Tivoli WebSEAL reverse proxy server, there are some specific

procedures and configurations you must employ to ensure the Sametime server can operate behind the 

WebSEAL reverse proxy server. These procedures and configurations are discussed below.


Note: The WebSEAL reverse proxy server must be listening on the default ports of 80 and 443 for the 

changes above to work.


To enable a Sametime server to operate behind a WebSEAL reverse proxy server:


1.	 You must configure the Sametime server to support HTTP tunneling on port 80. For instructions, refer 
to the "About HTTP tunneling" section in the "Configuring Sametime Connectivity" chapter of the IBM 
Lotus Instant Messaging and Web Conferencing (Sametime) 7.5 Administrator's Guide. 
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2.	 You must open the stlinks.js file on the Sametime server and modify the following two lines to point to 
your WebSEAL reverse proxy server and WebSEAL junction (the WebSEAL junction is "st" in the 
example below): 

varII_RProxyName="https://ampc0.support.tivlab.austin.ibm.com" 
varII_AffinityID="st" 

var is TAM-env=true;

//racingConnTimeout-Timeout between racing connections in milliseconds. The value is sent to the

STLinks applet var racingConn Timeout=5000;


To configure the server to work with STLinks in a regular (not TAM) environment, leave the following lines

in stlinks.js without any change:


var is TAM-env=false;

//racingConnTimeout-Timeout between racing connections in milliseconds. The value is sent to the

STLinks applet.


1.	 Enable reverse proxy support and specify the WebSEAL junction in the Sametime Administration Tool 
on the Sametime 7.5 server. 

- Open the Sametime Administration Tool on the Sametime 7.5 server. 

- Select Configuration-Connectivity. 

- In the "Reverse Proxy Support" section, select the "Enable Reverse Proxy Discovery on the client" 
setting to enable the reverse proxy support. 

- In the "Reverse Proxy Support" section, enter the WebSEAL junction name in the "Server Alias" 
field. In this example, "st" is the WebSEAL junction name. 

2.	 Create the Tivoli Access Manager WebSEAL junction as shown below: 

pdadmin> server task webseald-[servername] create -t tcp -h [sametime hostname] -p 80 -i -j -A -F [ 
path to LTPA key] -Z [LTPA key password]/junction 

You cannot use the -w parameter for this setup. Some requests generated by Sametime are not 
allowed through the junction if the -w exists. You must also ensure that the LTPA key used in the 
junction is the same LTPA key that the Sametime server uses in its Web SSO Configuration 
document 

After performing these configurations, you should be able to login to https://webseal/stjunction and be 
prompted by WebSEAL for authentication. Once authenticated, SSO between WebSEAL and Sametime 
should work and all requests for Sametime will route through WebSEAL. 
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Sametime Administrator needs to be in LDAP for policies to work

Existing Sametime customers that use LDAP have the Sametime Administrator in the local Domino

Directory. Until now, they didn't need to have a Sametime Administrator in LDAP; this is now required for

Policies.


Workaround 
Put the DN name of an LDAP user in the full name of the existing local Sametime Administrator, replacing 
commas with forward slashes.  By logging in to Sametime administration as the LDAP user, that user is 
automatically recognized as an administrator, and Policies will work.  In Domino LDAP, if the full DN name 
of the user is "CN=xxx/OU=yyy/O=zzz", you should add the user in the format "xxx/yyy/zzz" to the ACL of 
stconfig.nsf. 

Sametime Connect and HTTPS connections on port  443 or 563 
This release note discusses issues pertaining to Sametime Connect client connectivity on port 443. These 
issues include: 

z	 Connecting to the Community Services on port 443 when the Domino HTTP server is configured to 
listen for SSL connections on port 443 

z	 Sametime 2.5 Connect client compatibility issue when connecting to a Sametime 7.5 server on port 
443 or 563 

z	 Sametime 7.5 Connect client compatibility issue when connecting to a Sametime 2.5 server on port 
443 or 563 

z	 Community Services multiplexer on Sametime 7.5 server does not forward HTTPS connections on 
port 443 to the Domino HTTP server 

Connecting to the Community Services on port  443 when the Domino HTTP server is configured to

listen for SSL connections on port  443


Sametime installs on a Domino server. Web browser users connect to the Domino HTTP server when 
accessing the Sametime server. If the Domino HTTP server is configured to support SSL for Web browser 
connections, the Domino HTTP server is usually configured to listen for these HTTPS connections on port 
443 or port 563. 

Some Sametime Connect clients may operate in networks that require the clients to connect to the 
Internet or intranet through an HTTPS proxy. Many network environments that require users to connect 
through an HTTPS proxy only allow outbound connections to occur on port 443. If a Sametime Connect 
client operates in such an environment, the following configurations must exist on the Sametime Connect 
client and the Sametime server for the connection to be successful: 

In the Sametime Connect client Sametime Connectivity tab: 

z	 The "Community port" setting must specify port 443. 
z	 The "Use proxy" and "Use HTTPS proxy" settings must be selected. The IP address or DNS name of 

the HTTPS proxy server and port number used to connect to the HTTPS proxy server are also 
specified. 

z	 In the Sametime Administration Tool on the Sametime server, the Community Services Network - 
Address for HTTPS-tunneled client connections - Port number setting must specify port 443. 
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With these configurations, the Sametime Connect client connects to the HTTPS proxy, and the proxy 
connects to the Sametime server on behalf of the Sametime Connect client. The connection from the 
proxy server to the Sametime server Community Services occurs on port 443. The Community Services 
on the Sametime server must be configured to listen for the HTTPS connections on port 443 to ensure the 
connection can succeed. 

Note The configurations above enable Sametime Connect to establish a connection to a Sametime server 
through an HTTPS proxy server. The HTTPS connection method is used to establish the connection but 
the data passing over this connection is not encrypted with SSL.  

If the Domino HTTP server is also configured to listen for HTTPS connections on port 443, a conflict

occurs because the Sametime Community Services are also configured to listen for HTTPS connections

on the same port number.


In this scenario, you must assign an additional IP address to the Sametime server to ensure that both 
Web browser users and Sametime Connect client users can connect to the Sametime server on port 443. 
This configuration requires the following steps: 

z	 Bind the DNS name for the Sametime server to the Sametime HTTP server. 
z	 Add a new IP address to the Sametime server machine. 
z	 Map the new IP address to a new DNS name for the Sametime Community Services. This 

configuration is performed on the DNS server. 
z	 Use the Sametime Administration Tool to add the new DNS name to the Community Services 

connectivity settings on the Sametime server. This configuration enables the Community Services to 
listen for HTTPS connections on the new DNS name. 

z	 Configure the Sametime Connect clients to connect to the new Community Services DNS name. 

Note The configuration described below can enable either a Sametime 2.5 (or higher) Connect client to

connect to a Sametime 7.5 server on port 443 or 563.


Step-by-step instructions for these configurations are provided below. 

Step 1 - Bind the base DNS name for the Sametime server to the Sametime HTTP server . 

1.	 Open the Sametime Administration Tool and select Configuration-Connectivity-Networks and

Ports-Configure HTTP services on a Web page in its own window. The HTTP section of the Server

document in the Domino Directory opens and displays in a separate window on the computer.


2.	 Under the Basics heading in the "Host name" field, enter the base DNS name for the Sametime HTTP 
server (for example, www.sametime1.com). 

Under the Basics heading In the "Host name" field, also enter 127.0.0.1. This entry is required for the 
Sametime Administration Tool to operate in this configuration. Place a comma between the DNS 
name of the HTTP server and the 127.0.0.1 entry (e.g. www.sametime1.acme, 127.0.0.1) 

3.	 Click "Save & Close" at the top of the Server document. After the document closes, close the

Server-Servers view of the Domino Directory.
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Step 2 - Add a new IP address to the Sametime server machine . 

To add a new IP address to the Sametime server, you can either install an additional Network 
Interface Card (NIC) in the Sametime server machine or assign multiple IP addresses to a 
single NIC. 

To assign multiple IP addresses to a single NIC on a Windows machine: 

1.	 Open the Windows Control Panel. 

2.	 Click the Protocols tab. 

3.	 Select TCP/IP Protocols-Properties-Specify an IP Address. 

4.	 Click the Advanced tab. 

5.	 Use the Advanced IP Addressing screen to assign multiple IP addresses to a single NIC. 

Step 3 - Set up your DNS server to map the IP address to a DNS name for Sametime Community 
Services. 

After you have added a new IP address to the Sametime server, set up your DNS server to map the new 
IP address to a DNS name for the Sametime server Community Services. 

For the Community Services, map the IP address to the DNS name "community-xxx.xxx.xxx"  (where 
xxx.xxx.xxx is the DNS name that was bound to the Sametime HTTP server in step 1 above).


For example, you would map the new IP address to the DNS name "community-www.sametime1.com."


Step 4 - Configure the HTTPS-tunneling settings in the Sametime Administration Tool


You must specify the new DNS name and port number for Community Services HTTPS connections in

the Sametime Administration Tool.


1.	 Open the Sametime Administration Tool and select Configuration-Connectivity-Networks and Ports.


2.	 In the Community Services Network-Address for HTTPS-tunneled connections settings, specify the 
following: 

Host name: community-xxx.xxx.xxx  (Where xxx.xxx.xxx is the DNS name that was bound to the 
Sametime HTTP server. For example, community-www.sametime1.com.) 

Port number: 443 

With this configuration, the Sametime Community Services multiplexer will listen for HTTPS-tunneled 
connections on host name community-www.sametime1.com on port 443. 
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Step 5 - Configure the Sametime Connect clients to connect to the new DNS name of the Community

Services


To connect to a Sametime server configured to listen for HTTPS connections on the host name and port

specified above, the Sametime Connect client must have the following settings in the Sametime

Connectivity tab:


z	 The "Host" setting must specify community-www.sametime1.com. 

Note If a Sametime 2.5 Connect client connects to a Sametime 7.5 server using HTTPS on port 443 
or 563, it is only necessary to enter the server name (www.sametime1.com) in the "Host" setting of 
the Sametime 2.5 Connect client. For example, enter "www.sametime1.com" instead of 
"community-www.sametime1.com" in the "Host" field. For more information, see "Sametime 2.5 
Connect client compatibility issue when connecting to a Sametime 7.5 server on port 443 or 563" 
below. 

z	 The "Community port" setting must specify 443. 

z	 "Use proxy" and "Use HTTPS proxy" must be selected. Enter the host name and port on which the 
Sametime Connect client connects to the HTTPS proxy. 

Sametime 2.5 Connect client compatibility issue when connecting to a Sametime  7.5 server on port  443 
or 563 

The Sametime 2.5 Connect client is designed to use HTTPS tunneling on ports 443 or 563 to connect to a 
server that uses multiple IP addresses. 

When a Sametime 2.5 server is configured to listen for HTTPS-tunneled client connections on port 443 or 
563, the server listens for Community Services connections on the server name 
"Community-servername." For example, if your Sametime 2.5 server is named 
sametimeserver.acme.com, the server listens for HTTPS-tunneled Community Services connections on 
ports 443 or 563 on the server name "Community-sametimeserver.acme.com." The Sametime 2.5 server 
is hard-coded to prepend the string "Community-" to its server name when listening for Community 
Services connections on ports 443 or 563. This design in the Sametime 2.5 server accomodates the 
multiple IP address issues discussed in "Connecting to the Community Services on port 443 when the 
Domino HTTP server is configured to listen for SSL connections on port 443" above. 

The Sametime 2.5 Connect client is also hard-coded to prepend the string "Community-" to its Host

setting when its "Community port" setting specifies port 443 or 563. For example, assume the following

settings exist in the Sametime Connectivity tab of a Sametime 2.5 Connect client:


z	 Host - "sametimeserver1.acme.com" 
z	 Community port - Either port 443 or port 563 is specified. 

With this configuration, the Sametime 2.5 Connect client attempts the connection to the server

name "Community-sametimeserver1.acme.com" even though the string 

"sametimeserver1.acme.com" is entered in its Host setting.


Because the Sametime 2.5 Connect client automatically prepends the string "Community-" to its host 
name, it is not necessary to enter the string "Community-servername" in the Sametime 2.5 Connect client 
when this client connects to a Sametime 7.5 server that is configured to listen for HTTPS connections on 
multiple IP addresses. 

Note also that when a Sametime 7.5 server listens for HTTPS-tunneled connections from Sametime 2.5 
Connect clients, the additional DNS name assigned to the Community Services on the Sametime 7.5 
server must begin with the "Community-" string, as described in "Connecting to the Community Services 
on port 443 when the Domino HTTP server is configured to listen for SSL connections on port 443" 
above. If the Sametime 7.5 Community Services DNS name does not begin with the "Community-" string, 
the Sametime 2.5 Connect client cannot connect to the Sametime 7.5 server.   
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Sametime 7.5 Connect client compatibility issue when connecting to a Sametime  2.5 server on port  443 
or 563 

If a Sametime 7.5 Connect client connects via HTTPS-tunneling to a Sametime 2.5 server on port 443 or 

563, the Sametime 7.5 Connect client does not prepend the "Community-" string to its host name when

making the connection to the Sametime 2.5 server.


The Sametime 2.5 server is hard-coded to prepend the string "Community-" to its server name when 

listening for HTTPS connections on port 443 or 563. To ensure the Sametime 7.5 Connect client can 

connect to the Sametime 2.5 Community Services on port 443 or 563, the string "Community-" must be 

manually added to the Host name in the Sametime Connectivity tab in the Sametime 7.5 Connect client. 


Manually adding the "Community-" string to the Host name in the Sametime 7.5 Connect client ensures 

that the client attempts the connections on the name on which the Sametime 2.5 server listens for the 

connections.


For example, to ensure a Sametime 7.5 Connect client can connect on port 443 or 563 to the Sametime 
2.5 server named "sametimeserver1.acme.com," the following settings must exist in the Sametime

Connectivity tab of the Sametime 7.5 Connect client:


z	 Host - "Community-sametimeserver1.acme.com." 
z	 Community port - Either port 443 or port 563 is specified. (Specify the port on which the 

Sametime 2.5 server listens for HTTPS-tunneled connections.) 

Community Services multiplexer on Sametime  7.5 server does not forward HTTPS connections on port

443 to the Domino HTTP server


A Sametime 7.5 server can simulaneously listen for HTTP connections to multiple services on port 80 

when the Sametime server machine includes a single IP address. For example:


z	 A Web browser can connect to the Domino HTTP server on a Sametime server on port 80. 
z	 A Sametime Connect client can make an HTTP-tunneled connection to the Sametime 

Community Services on port 80. 
z	 A Sametime Meeting Room client can make HTTP-tunneled connections to both the 

Sametime Community Services and Meeting Services on port 80. 

All of these connections can occur to the same DNS name using port 80. On a Sametime 7.5 server, it is 
not necessary to assign separate IP addresses to the HTTP Services, Community Services, and Meeting 
Services to enable connections to all services to occur using a single DNS name on port 80. The design 
of the Community Services multiplexer on a Sametime 7.5 server makes this capability possible. The 
Community Services multiplexer can listen for HTTP connections from Web browsers, Sametime Connect 
clients, and Sametime Meeting Room clients on port 80. The Community Services multiplexer examines 
these connections and then forwards the connections to the appropriate service. For example, the 
Community Services multiplexer forwards the Web browser connections to the Domino HTTP Server, the 
Community Services connections to the Community Services, and the Meeting Services connections to 
the Meeting Services. 

Note that the Community Services multiplexer on a Sametime 7.5 server cannot listen for connections on 
port 443 or 563 and then forward these connections to the Domino HTTP server. The Community 
Services multiplexer can forward HTTP connections on port 80 to the Domino HTTP server, but not 
connections on port 443 or 563. For this reason, a Sametime 7.5 server must be assigned multiple IP 
addresses when both the Domino HTTP server and the Sametime Community Services on the Sametime 
server must listen for connections on port 443 or 563. 
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Note The Community Services multiplexer on a Sametime 7.5 server also cannot listen for HTTPS 
connections to the Sametime Meeting Services or Community Services on ports 443 or 563 and forward 
these connections to the Community Services and Meeting Services. HTTPS-tunneling to the Sametime 
Meeting Services is not supported. Sametime Meeting Room clients cannot connect to the Sametime 
Meeting Services through an HTTPS proxy server. 

Windows DEP process causes launch error 
If Windows server administrators are running the Data Execution Prevention (DEP) process on their 
Windows server, the server will view the Sametime launch task StLaunch as a potentially malicious 
thread, and halt the process. The error message received is: 

To Help protect your computer, Windows has closed this program:Name: 
StLaunchPublisher: 

Workaround 
Turn off the DEP process on Windows servers before launching the StLaunch task. 

Adjusting the logging level in sametime .properties 
For the Sametime client, the properties relevant to logging into sametime.properties are described 
below. The sametime.properties file is found in the installation root.  By default the .level value is 
set to INFO. 

## Logging properties
.level=INFO 
logger.filename=sametime.log 
logger.includeClassInfo=true 
logger.toConsole=true 
logger.level=ALL 
logger.limit=20000000 
logger.count=4 
redirectSystemOutput=false 

.level 
The default logging level for the application.  This level is applied to the root logger, and the level that 
should be changed to trigger more verbose logging. 

The options from most verbose to least verbose are as follows: 

FINEST 
FINER 
FINE - shows fine messages, which produces much useful debug information 
INFO - default level 
WARNING 
SEVERE 

If experiencing a bug, set .level to FINE, reproduce the problem and examine the sametime.log.0 
file located in the user workspace, typically "C:\Documents and 
Settings\<username>\Application Data\Sametime" on a Windows system. 
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Clustered Sametime communities should have single host name 
When configuring a Sametime server cluster with multiple nodes, it is important to front-end the cluster or 
"community" with a single virtual host or DNS name.  The ST 7.5 client makes a direct connection 
between a "community" and host name as entered in the client connectivity settings. This means that if a 
user enters "Node A" as the host name and then changes it to "Node B", they will not see users online, 
because users of "Node A" are not recognized as belonging to "Node B". 

This restriction will be relaxed in future releases, but in order to avoid such issues it is important to 
front-end the cluster with an IP sprayer or other mechanism that provides a single virtual host name to the 
community. This is a good practice, as it provides for added administration flexibility for replacing nodes 
without affecting end user clients, and without coupling the clients to specific machine host names. 

Conversion Services on Windows Sametime servers 
Sametime Conversion Services is a feature that takes files of various formats (slides, images, documents, 
etc.) and provides a bitmap rendering, so they can be shared in a meeting as slides.  Sametime 
Conversion Services has been enhanced for Sametime 7.5 to use new conversion technologies that 
provide more faithful rendering of slides.  When you install Sametime 7.5 on Windows, Sametime 
Conversion Services is always installed on the server as a Domino servlet. This is a change from previous 
releases that administrators of Windows Sametime servers need to be aware of in the following situations: 

z	 Windows Sametime server configured for SSL 
If you have an existing Sametime server running on Windows that is configured to encrypt Web 
browser connections with SSL, you must manually update a file on your Sametime server after 
upgrading to Sametime 7.5.  After upgrading your Sametime server, you must modify the 
conversion server configuration so that Sametime can continue to access the conversion servlet. 
If you do not update the conversion server configuration, meeting file attachments will not be 
converted for display in the meeting room as slides. 

You must make similar changes to the conversion server configuration if you decide to configure 
your Sametime 7.5 server for SSL at a later time. 

For detailed instructions, see “Securing Conversion Services with SSL” in the Sametime 7.5 
Administrator's Guide. Complete the step that describes how to update the 
stconvservices .properties file.  On Windows, this file is located in the Sametime binary directory 
(usually C:\lotus\domino). 

z	 Reconfiguring Domino HTTP on Sametime server 
When you install Sametime 7.5, the Sametime server is automatically configured so that it can 
properly access the conversion servlet. If you decide to reconfigure Domino HTTP on your 
Sametime 7.5 server to use a different IP address or port, you must update the 
stconvservices .properties file with the correct IP address and port so that the Sametime server 
can continue to access the conversion servlet. On Windows, this file is located in the Sametime 
binary directory (usually C:\lotus\domino). 
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Multiple Community considerations 
The 7.5 Sametime Connect client supports the ability to define multiple Sametime communities in an 
interface, and be logged into one or more of those communities at the same time.  There are some 
important points to consider if you need to define more than one community or switch from one 
community to another: 

z	 If you have multiple communities in which some are 7.5 communities and some are pre-7.5 
communities, you should define your primary community (the main community defined first when 
the client is first run) as your most used 7.5 community. 

z	 Some features in 7.5 work only with your primary community and require policies to be enabled 
for them, for example, voice chat and telephony.  You will not be able to voice chat or participate 
in telephony calls with users of a community that is not defined as your primary community. 

z	 Selective 'Do Not Disturb' requires a 7.5 server, and will only work with users from your primary 
community 

New UNIX config values not always propagated by single restart 
At a high level, configuration values on a Sametime server are provided to system components by a 
configuration servlet.  The values provided by this servlet are stored in a cache to improve performance. 
When system components retrieve values, these values come from the cache. 

If configuration changes are made directly to a data source, such as STConfig.nsf or sametime.ini, the 
server must be restarted.  On Windows, as the server comes up, the config cache is refreshed from the 
config servlet before system components can retrieve values from the cache. 

On UNIX, however, the order of component startup is more random than on Windows. As a result, it's 
possible that system components will retrieve configuration values from the cache before it gets 
refreshed.  As a result, the refresh of the cache occurs after values have already been retrieved. If this 
happens, a second restart of the server will guarantee that system components retrieve the freshest 
configuration values. 

There are a couple of other methods for changing configuration values that should assure retrieval of the 
latest values: 

1. Make the configuration changes.

2 Stop the server. 

3. Delete the file 'SametimeCommunity2.xml' from the data directory. 

4. Restart the server. 

Or method: 

1. Make the configuration changes.

2. In the Domino console, restart the HTTP server with the command 'tell http restart'. 

3. Wait a few moments for Domino to respond that the HTTP server has restarted. 

4. Restart the entire server.

Either of these methods should cause sytem components to retrieve the latest configuration values. 
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Real-Time Collaboration Gateway replaces Sametime SIP Gateway 
The SIP Gateway and SIP Connector which were delivered with earlier releases of Lotus Sametime are 
not included with Lotus Sametime 7.5.  The ability to share presence and exchange text-based instant 
messages previously provided by these components are now being provided by the new IBM Lotus 
Real-Time Collaboration Gateway. 

The Real-Time Collaboration Gateway is an extensible platform built on WebSphere Application Server, 
and allows various real-time collaboration communities such as IBM Lotus Sametime and public instant 
messaging (IM) services to share presence and exchange text-based instant messages with each other. 
The Real-Time Collaboration Gateway receives messages from one or more communities, checks their 
legitimacy, translates them if necessary, and forwards them to their destination. 

Enabling the Real-Time Collaboration Gateway functionality requires the installation of  separate 
components which will be available shortly after the general availability of Lotus Sametime 7.5.  As more 
information becomes available, it will be posted on the Lotus Sametime home page: 

http://www.ibm.com/lotus/sametime 

When the Real-Time Collaboration Gateway is available for Sametime 7.5, you will be able to view the 
IBM Lotus Real-Time Collaboration Gateway information center at: 

http://publib.boulder.ibm.com/infocenter/rtchelp/v1r0/index.jsp 

Until the RTC Gateway is released, customers who want to continue using SIP to communicate with other 
communities should follow the steps in technote #1244026 before upgrading their server to Sametime 
7.5: 

http://www.ibm.com/developerworks/lotus/support/ 

Sametime 7.5 does not provide a virus scanner 
Sametime 7.5 does not provide a virus scanner. However, Sametime 7.5 can be configured to call a 
third-party virus scanning program before transferring a file. 

Do not choose "Always" as the value for "Virus scan files before transferring" in Sametime Administration 
unless you have acquired and deployed a virus scanning program. 

UIM Client file transfer overview 
The UIM client can transfer files by either one of two methods: via the server (RTC), or via peer to peer 
(P2P). The method is chosen programmatically at runtime and depends on server, as well as client, 
settings. 

Server file transfer  (RTC) 
When this method is used, the UIM client will call upon the Real-Time Collaboration (RTC) API to transfer 
the file.  The RTC layer then communicates directly with the Sametime server, and passes the file through 
the server, to the receiving user. RTC file transfers honor the existing Sametime user policies for 
allow/disallow file transfer, maximum size of file allowed, and file types disallowed from transfer. 

Peer-to-peer file transfer (P2P) 
When this method is used, the UIM client will attempt to connect directly to the chat partner's machine, 
and transfer the file if a successful connection is established.  P2P file transfers bypass all Sametime user 
policy checks.  In order to be able to use this transfer method, the user's sametime.properties file must 
contain the p2p flag (filetransferP2pAllow) set to 'True'. This file can be found in the UIM client 
install directory. 
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Virus Scanning 
Though not directly related to 'how' a file is transferred, the existence of the virus scanner in the Sametime 
server helps determine 'which' method is used for transfer. The Sametime server has hooks to allow for 
the operation of a third-party virus scanning tool.  If the server is configured to virus scan, then the method 
used for transfer must be the server.  P2P file transfers do not get scanned for viruses. 

RTC or P2P? 
The first thing that needs to be determined is whether or not the user is allowed to transfer files.  This is 
done by first looking at the Sametime server setting for “Community Services – Allow users to transfer 
files”.  This is a global setting that affects all users in that Sametime community.  This setting is then 
combined with the Sametime User Policy setting.  The outcome is the final UIM policy for file transfer.  
The following table shows the possible outcomes in this scenario. 

Sametime User Policy Sametime User Policy 
allows file transfers does NOT allow file 

transfers. 

Sametime server allows UIM client allows file UIM client does NOT 
users to transfer files transfers. allow file transfers. 

Sametime server does UIM client does NOT UIM client does NOT 
NOT allow users to allow file transfers. allow file transfers. 

transfer files 

- The UIM client does NOT allow file transfers .

If the UIM client does not allow file transfers and both users' (sender and receiver) 

sametime.properties file contains the P2P flag (see above), and both users have P2P capability,

then the file transfer will occur via P2P; any UIM Sametime 7.5 client has P2P capabilities.


- The UIM client allows file transfers .

Once you know you have permission from the server to transfer files, the next step is to check 

whether or not you have a working virus scanner on the server.


- Virus scanning is enabled on the server
With virus scanning enabled on the server, the file transfer will occur via the server (RTC) 

with a message on the chat window indicating this.


- Virus scanning is not enabled on the server
If virus scanning is not enabled on the server, the file transfer will occur via P2P, if the

users (sender and receiver) both have the P2P flag set and have P2P capability.  A 

message is displayed in the chat window indicating that the file will not be scanned for

viruses.


In the event that either user does not have P2P flag enabled or capability, the file will be 
transferred via RTC, also with a message in the chat window indicating that the file will 
not be scanned for viruses. 

UIM 7.5 Client and pre–UIM 7.5 Client 
File transfer between the 7.5 client and pre-7.5 clients will always go through the server.  Pre-7.5 clients 
are not P2P capable. As such, when chatting from a 7.5 client to a pre-7.5 client, if file transfer is not 
allowed in the user Policy, then the file transfer icon will be disabled for the pre-7.5 client user.  This is the 
result of a “Capabilities” check. 
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Which transfer method is my client using?

Debug sametime client logs are needed to determine this:


1.	 Open sametime.properties 
2.	 Set “.level” to “FINE” (.level=FINE).  NOTE: do not confuse ‘.level’ with ‘logger.level’. 
3.	 Use your client for file transfer 
4.	 Go to the Sametime user folder (this is not the install folder; the Sametime user folder can found 

within the user’s C:\Documents and Settings folder) 
5.	 Locate file name sametime.log.0 

Server (RTC) file transfer logging will look like this: 

[com.ibm.collaboration.realtime.filetransfer.FileTransferServiceFactory. 
getService] ::FINE:: File Transfer enabled in Policy
[com.ibm.collaboration.realtime.filetransfer.FileTransferServiceFactory. 
getService] ::FINE:: Virus scanning is available for this file transfer
[com.ibm.collaboration.realtime.filetransfer.FileTransferServiceFactory. 
getService] ::FINE:: Virus Scanning is enabled.  Using RTC file
Transfer. 
[com.ibm.collaboration.realtime.filetransfer.rtc.FileTransferServiceRtc 
.fileTransferStarted] ::FINE:: RTC File Transfer Started... 
[com.ibm.collaboration.realtime.filetransfer.rtc.FileTransferServiceRtc 
.fileTransferCompleted] ::INFO:: RTC File Transfer Completed 

P2P file transfer logging will look like this: 

[com.ibm.collaboration.realtime.filetransfer.FileTransferServiceFactory. 
getService] ::FINE:: File Transfer disabled in Policy.  Using P2P. 
[com.ibm.collaboration.realtime.filetransfer.FileTransferServiceFactory. 
getService] ::FINE:: Virus scanning is not available
[com.ibm.collaboration.realtime.filetransfer.
.startTransfer] ::FINE:: Transfer started... 

p2p.FileSender 

[com.ibm.collaboration.realtime.filetransfer.p2p.FileSender
.closeFileInputStream] ::FINE:: Closing file input stream... 
[com.ibm.collaboration.realtime.filetransfer.p2p.FileTransferServer.addF 
ileSender] ::FINE:: added id1155131608343 
[com.ibm.collaboration.realtime.filetransfer.p2p.FileTransferServer.star 
tServer] ::FINE:: Starting filetransfer server on port 5656 
[com.ibm.collaboration.realtime.rtcadapter.meeting.ChatAdapter.messageRe 
ceived] ::FINE:: messageReceived [meeting CONV$4DEA2B75C606C469] msg 
type: text 
[com.ibm.collaboration.realtime.filetransfer.p2p.FileSender.onTransferAc 
cepted] ::FINE:: [Transfer accepted] notice received 
[com.ibm.collaboration.realtime.filetransfer.p2p.FileSender.onTransferAc 
cepted] ::FINE:: Transfer accepted by receiver. Testing connectivity... 

Voice chat and Network Address Translation  (NAT)

The Sametime 7.5 voice chat component provides Voice over IP (VoIP) services.  To work correctly, voice

chat needs to have the network configured properly.  Voice chat works with UDP packets; it needs UDP 

ports to be opened on the firewall of every 7.5 client. The clients are using a single port (UDP port 20830) 

for all audio chats; this port needs to be opened for both incoming and outgoing UDP traffic.


Voice chat operates in two different modes:


z	 Direct P2P connection: UDP packets flow directly between users 
z	 Reflector connection: UDP packets go through an audio proxy, called a "reflector", which is a 

piece of code installed with the Sametime 7.5 server 
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In both modes, the firewall needs to let the UDP (port 20830) traffic flow in both directions.  The direct P2P 
connection is used whenever possible, and is the recommended way of using voice chat. 

The reflector mode is only used when a specific type of NAT (symmetric NAT) is detected.  In that case, 
since both clients are unable to guess each other's IP address to establish a P2P connection, the UDP 
packets are relayed through the reflector. 

This mode is used for compatibility, and performance will not be as good as direct P2P.  Consequently, 
the user could experience additional delays, and a decrease of quality in the voice chat, depending on the 
ST 7.5 reflector availability. 

For NAT environments, the reflector will be used.  The reflector uses 2 TCP/UDP ports: 

- 20831
- 20832

Those ports must be opened for incoming and outgoing UDP and TCP traffic, on the reflector machine.  It 
is recommended that the reflector machine have a static IP address. 

In case the reflector is running on multiple network interfaces, it must be configured with either a 
hostname or an IP address, so that clients know which address to use to connect to the reflector. 

For example, in the [STReflector] section of the sametime.ini file 

STREFLECTOR_SERVER_NAME=reflector.domain.com 

or 

STREFLECTOR_SERVER_NAME=192.168.1.1 

If the reflector is located in an environment with two different subnets, the reflector needs to be accessible 
from different networks, hence the property STREFLECTOR_SERVER_NAME should be a fully-qualified 
hostname, which resolves to the appropriate addresses in both networks/subnets. 

In case the 7.5 client is running against a pre-7.5 server, the voice chat component may not 
work correctly in a number of cases: 

z	 The client has multiple network interfaces (in that case, the 7.5 client might get confused as to 
which interface should be used) 

z	 The client is sitting behind a router/NAT 

The symptoms experienced by the client in these cases is that one (or both) of the parties in the voice 
chat will not be able to hear each other, even though the chat window will show a "connected" status.  To 
confirm the problem, the user can increase the log level of the client to FINE, and look in the log for 
entries related to "reflector".  The IP detection problem will be signaled. 

The 7.5 client has the ability to host calls with up to 5 participants, including the host.  During such calls, 
the host is the creator of the call.  The host will mix the audio streams for each participant.  Consequently, 
the host will have up to 4 incoming/outgoing audio streams, which will multiply the amount of bandwidth 
necessary.  It is recommended that for multi-party voice chats, the client with the most bandwidth hosts 
the call. 

Sametime 7.5 is using the iSAC codec for all voice chats.  This codec is an adaptive bandwidth codec, 
which requires between 10.6 to 28.8 kbits (headers included), depending on the voice activity and the 
network quality. For example, during a 3-way call, the host will require twice that amount (between 21.2 
and 57.6 kbits), both incoming and outgoing.  The other 2 participants, will only require between 10.6 and 
28.8 kbit/s. 
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The CPU requirement for hosting calls is 'medium': a 1GHz machine can easily mix a 3-way call; a 2GHz 
machine can mix a 5-way call easily.  During a voice chat call, the Sametime process is running at high 
priority under Windows (regular priority under Linux), because voice processing needs to be real-time to 
avoid quality issues. After the call terminates, the process goes back to normal priority. 

If the user drags windows around (especially chat windows), or does some other activity which is either 
CPU or network intensive, the quality of the call will decrease.  The codec will try to automatically recover 
when conditions improve. This process can take a few seconds. By pausing/resuming their calls (by 
clicking the "pause" / "resume" button on the audio toolbar of the chat window), the user can force a 
"reset" of the call quality; this is equivalent to ending and starting a new call. 

It is recommended that you disable or reduce any download or other CPU-intensive activity during a call, 
in order to obtain maximum quality.  Network administrators might want to mark the UDP packets from 
port 20830 with a higher class of service in order to increase voice quality. 
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Chapter 3 - Known limitations, problems, and 
workarounds 

Limitations 

Installation issues 

Sametime Connect for Browsers is not included with Sametime  7.5 
Lotus Sametime Connect for Browsers is not included with Sametime 7.5.  If Sametime Connect for 
Browsers is needed for your Sametime 7.5 installation, see technote 1243158, "Deploying Sametime 7.0 
Connect for Browsers on a Sametime 7.5 server", at: 

http://www.ibm.com/support/docview.wss?rs=203&uid=swg21243158 

Telephony MSP can not be installed to Turkish OS 
The Telephony Mock Service Provider can not be installed on a Turkish-localized operating system.  This 
is a known and documented InstallShield issue, caused by a bug in the open source hsqldb engine: 

http://support.installshield.com/kb/view.asp?articleid=Q110959 and 
http://sourceforge.net/tracker/index.php?func=detail&aid=900902&group_id=23316&atid=378131 

Workaround 
Temporarily switch to an English locale during the installation. 

Use only ASCII characters for client installation path 
There is a known problem with installing the Sametime Connect client to a path that includes DBCS 
characters, for example, Chinese, Japanese or Korean.  Please use only ASCII characters when 
selecting an installation location for this release. 
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Client issues 

Directory Browsing supports one directory per community 
Directory Browsing from the Add Contact dialog currently only supports one directory for each community 
the user is logged into.  There is not an additional selection for multiple directories. 

Features not available with pre-7.5 server configurations 
When using the 7.5 Sametime Connect client in enviroments that have pre-7.5 servers, the following 
features will not be available: 

1. Business cards with extended user information and pictures 

2. Selective 'Do Not Disturb' 

3. Automatic "In a Meeting" status change when in meetings 

4. Support for voice chat in configurations with NAT 

Linux: Automatic Reconnect not working 
Automatic reconnect when losing network connectivity in the Linux Connect client does not work.  This 
feature works only on the Windows connect client. 

Linux: Chat history can not be printed out 
On Linux, selecting a Chat history, and then selecting File -> Print, does not work. 

Machines with only the Firefox browser are not supported 
The Sametime Connect 7.5 client does not support configurations where the only browser installed on the 
machine is Firefox.  This may be, for example, a Windows machine where Internet Explorer has been 
uninstalled, or a Linux machine where only Firefox is installed. 

Orange frame used as a selection aid is not drawn on Linux 
When using Linux, Sametime does not draw an orange frame around the application that is highlighted in 
the Sharing dialog. 

Possible Linux sound issues with OSS 
Sametime Connect 7.5 for Linux ships with OSS by default.  If other application are using OSS, the 
Sametime Connect client may not be able to play sounds or participate in voice chats.  This is a known 
OSS issue regarding applications sharing the system sound correctly. 
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Running in a hybrid environment with pre -7.5 clients 
The Sametime Connect 7.5 client can run in an environment with a mixture of new and old Sametime 
clients.  Note that you will not be able to send rich text to pre-7.5 clients, and that the rich text tools will be 
disabled in such a client. Also note that when switching to "In a Meeting" status, you will be seen by older 
clients as "Online" with no status icon. 

Some network connectivity options not available on Linux Connect 
The Linux Connect client does not support the following connectivity options, and they will not work even 
though they are available: 

1. HTTP proxy with authentication 

2. HTTPS proxy 

3. Reverse proxy 

Contact issues 

Voice Chat only works with primary community 
You can only create voice chat sessions with other users in your primary community. Although the voice 
chat menu will be available for users from other communities, if you defined such additional communities, 
the feature is limited in this release to work only with your primary community. 

"$" character in business card retrieving data from Domino LDAP 
Domino LDAP adds the "$" sign to the postalAddress attribute.  Therefore, when users' details are 
being retrieved from Domino LDAP, the value for Location contains "$" signs.  Since the value of this field 
is a concatenation of 3 other fields in the Name and Address Book (City, State/Province, and Country), a 
possible workaround is to fill only one of these fields. 

Internationalization issues 

Click To Call may not work correctly for Turkish locale 
For a Turkish locale setting, Click To Call may not work as expected. 
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i5/OS: Avoid Turkish locale to install language pack from web 
If you use are using the Turkish locale and attempt to install the i5/OS language pack using the Web 
download version, several of the available languages are not displayed for selection. 

You should temporarily set the system locale to something other than Turkish before running the 
RSTLSTLNG command to install the language pack.  For example, 

CHGSYSVAL SYSVAL(QLOCALE) VALUE(*NONE) 

After you install the language pack, change the system locale back to Turkish.


Note: this is not a problem when installing the language pack from CD.


Linux: Date displays incorrectly for Login page

If running on Linux, the date or time may display as unreadable characters from the Administration -> 

Monitoring -> Login page.


Meeting issues 

Conversion Service failure produces no error message 
In Sametime 7.5, the Conversion Service can be configured in such a way that conversion takes place on 
a remote server.  If, for some reason, a connection cannot be made to this remote server during the 
conversion process, the user will not see any error messages on the screen.  The only symptom will be 
that a file is not attached to the Whiteboard.   A detailed error message, however, will be printed in the 
logs. 

Dual monitors not supported 
The Screen Sharing feature in online meetings does not support dual/multiple monitors.  Only data on the 
primary display/monitor can be shared. 

IME may disappear when XP users share entire screen 
If the Input Method Editor (IME) is not minimized in a taskbar, it may sometimes disappear when XP users 
share their entire screen in a meeting. 
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In telephony, Mute may not work as expected 
When using telephony, the Mute features may not work as expected, depending on how the audio bridge 
responds to the Mute requests. 

1. When the moderator chooses "Mute All", a mute with lock may result on everyone in the meeting 
except the moderator.  If any users need to be unmuted, the moderator must unmute those users. 

2. When a user mutes himself, a mute with lock may result.  If this user needs to be unmuted, the 
moderator must unmute the user. Furthermore, anytime a user mutes himself, the moderator may 
unmute the user at any time. 

Linux: Meeting page may overlap with frame border 
If you are using Mozilla on Linux, the meeting page may overlap with the frame border. 

Preferences/Status Messages - In a Meeting settings 
In the Status Messages section of Preferences, the settings for "In a Meeting" do not consistently occur if 
the user changes the status by entering an online meeting from a community that is not the primary 
community. The primary community is the first one the UIM client was set up with. 

Some German characters may not work in shared application 
Sometimes, when a remote user inputs special German characters into a shared application during a 
Sametime meeting, the application may not work correctly. 

The date/time format in unlisted meeting pages is unlocalized 
When searching for an unlisted meeting, the date/time format in the search results may not follow a 
language-specific format. 

Users joining multiple meetings 
Users can log in to only one meeting on one Sametime server at a time.  If users want to join more than 
one meeting or web conference at a time, they can do so only if a Community Services cluster has been 
created. 

If a user logs in to a meeting, then attempts to log in to a second meeting, he or she is evicted from the 
first meeting, and refused access to the second meeting. To solve the problem, create a community 
services cluster, and specify the cluster in the configuration for the home Sametime server. 
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When shared window is obstructed users will see gray 
When a user is Screen Sharing an application window in a meeting, and that window is obstructed by 
another application/window, participants in the meeting will see the shared area grayed out.  This is a 
security feature, to ensure only the desired application is visible to meeting participants. 

To avoid this problem: 

1. Make sure your shared window/application is not obstructed by another window/application. 

2. Use either "Share a resizable frame" or "Share Desktop", in which case the frame or desktop 
cannot be obstructed. 

Year/Month format is not localized in Calendar dialog 
The Year/Month format may not follow a pre-determined, language-specific format in the Meeting center 
Calendar dialog. 

"Join the Call" button may take a few moments before enabling 
When using the Telephony tools in an online meeting, it is possible for the "Join the Call" button to take a 
few moments after successfully connecting to the telephony service provider to bcome enabled.  This is a 
factor of how quickly the Telephony Service Provider (a third-party component) notifies the Meeting Room 
Client that a user may join the call. 

Be patient after entering the telephony service provider required information; the "Join Call" button will be 
enabled. 

Server issues 

Do not create a Name Change Task with a non -existent file 
When creating a new Name Change Task, if you use a non-existent file, the function may not react 
correctly and return JavaScript errors. 

Domino Web Administration does not support Firefox  1.5.x 
When using Mozilla Firefox 1.5.x to access Sametime Web Administration, the linked Domino Web 
Administration does not support using Firefox 1.5.x; only Firefox 1.0.x is supported by Domino. 
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Internet e-mail addresses not supported in LDAP attribute 
If a Sametime server is setup to use an LDAP directory, there is an optional setting in stconfig.nsf that 
specifies the LDAP attribute to use for the internal Sametime ID of a user.  This setting cannot contain an 
LDAP attribute that holds the internet e-mail address for users.  If it does, then web conferences that are 
restricted to certain users will not work properly and other user-restriction related features may be broken 
in Sametime. 

Telephony Mock Service Provider allowed to coexist with Avaya SP 
A Sametime server does not support both the Mock Service Provider and an Avaya Service Provider 
installed simultaneously.  The installer for the Sametime 7.5 Telephony Mock Service Provider does not 
currently check for an existing Avaya Service Provider on the server (likewise, an Avaya Service Provider 
may not check for another existing service provider on the system).  As a result, a user will be allowed to 
install both service providers on a server, even though doing so will not result in a working configuration. 

To avoid this problem, never install both of these service providers simultaneously on a single Sametime 
server. 

Users appear offline logging into discrete nodes of a cluster 
Users in the buddy list are associated with a community; a community is unique, according to a hostname 
and user ID. Therefore, when logging into discrete hosts that represent a single, logical Sametime server, 
a new community is created for each one. Users associated with a particular community will only show 
awareness when logged into that community's host. 

Web conferencing issues 

Directory dialogs do not show a user's online status 
The Directory and Invite dialogs do not correctly show added users' online status.  A previous issue with 
not showing a user's capabilities (video camera, speakers, microphone) has been fixed. 

Leave Meeting fails in certain configurations 
With some versions of Mozilla/Firefox the "Leave Meeting" functionality fails in an Instant Meeting.  When 
a user launches an Instant Meeting from the new instant messaging client using some versions of 
Mozilla/Firefox for the meeting, the "Leave Meeting" from the file menu may not work.  This is due to 
Mozilla/Firefox not allowing JavaScript code to close the primary browser window.  This does not affect 
scheduled meetings, and is not seen in Internet Explorer. 
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Password is not case-sensitive using Mozilla with RedHat 3.0

When using a Mozilla browser to create a password-protected web conference, running with RedHat 3.0, 

the meeting password is not case-sensitive.


Premiere Global Services audio adapter not supported 
The IBM Lotus Web Conferencing Audio Adapter for Premiere Conferencing (now Premiere Global 
Services) for Lotus Sametime 6.5.1 and Lotus Sametime 7.0 is not supported for Lotus Sametime 7.5.  
For information on how to connect Lotus Sametime 7.5 with audio services from Premiere Global 
Services, please visit: 

http://www.premiereglobal.com/ilwc/ 

Set maximum number of days for Web Conferences in Notes .INI 
A new feature has been added to Sametime 7.5 that allows administrators to limit how far in the future a 
web conference can be scheduled. This setting cannot be set from the Sametime Web Administration 
application, but instead must be configured in the Notes.INI file of the Sametime server.  Administrators 
should set the parameter in Notes.INI as follows: 

STScheduleLimitDays=10 

The value of this parameter is the number of days in the future that a Web Conference can be scheduled 
to end. By default there is no limit, and setting this limit will cause a JavaScript alert box to pop-up when a 
user tries to schedule a web conference that ends more than the specified number of days from the 
current server time. This check is done only on the client at the time a web conference is scheduled, 
therefore existing web conferences will not be affected. 

StarOffice Calc and Impress files cannot be shared 
Sametime Web Conferences do not support StarOffice Calc (.SXC) or StarOffice (.SXI) Impress files on 
the Whiteboard. These file types cannot be added to a new Web Conference on the Slides tab, nor as 
dynamic attachments during an active Web Conference. 
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Known problems and workarounds


Installation issues 

Sametime setup fails when xACL enabled for Domino Directory 
Currently, Sametime cannot be installed successfully when the Domino Directory (names.nsf) is 
configured to use an extended ACL (xACL). In order to install Sametime successfully, a customer must 
first disable xACL support for the Domino Directory.  After installing Sametime, the customer may then 
re-enable the xACL. Extended ACL support can be configured by opening names.nsf in a Notes client, 
navigating to File -> Database -> Access Control, and then clicking on the Advanced tab. 

Client issues 

Acrobat Reader must be installed for some autorun links to work 
The Autorun links for 'Release Notes', 'Installation Guide', and 'Administration Guide' will not work unless 
Acrobat Reader has been installed. 

Issue receiving emotion icons and images on a Linux client 
There is a known issue receiving emotion icons and images sent by a Windows connect client to a Linux 
connect client.  In this case, the images will not be displayed on the Linux client; this is not the case for 
images sent from Linux to a Linux client or from Linux to a Windows client. 

Contact issues 

Preventing errors when UserInfo servlet processes updates 
To prevent errors when the UserInfo servlet processes updates that are generated by Administrator 
changes, the following steps are required: 

1. In the file UserInfoConfig.xml, set the value property of the "ReadStConfigUpdates" tag to 'True' 

2. Restart the HTTP service 

Note: This issue affects only Sametime servers that are configured to work with a Domino directory. 
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Retrieving Photos from Domino 6.5.1 LDAP directory with UserInfo 
Binary data cannot be correctly retrieved from a Domino 6.5.1 LDAP  Directory, therefore, if UserInfo is 
configured to retrieve data from a Domino 6.5.1 LDAP directory, the photos will not be retrieved.  To 
successfully retrieve photos from a Domino LDAP directory, the directory should be upgraded to Domino 
6.5.4 or higher, where this issue has been addressed. 

Setting the company name for Domino LDAP 
To display the company name in the business card when the Sametime server is pointing to a Domino 
LDAP directory, use a third-party LDAP management tool to add a value to the LDAP "ou" attribute.  The 
Name and Address Book contains a hidden field for the LDAP attribute "ou", which can not be set through 
the Name and Address Book. 

Internationalization issues 

Do not use Japanese characters in UIM plug -in download path 
In UIM Update Manager, users may experience an error when using Japanese characters as part of the 
plug-in download path.  Do not use Japanese characters in the download path. 

Do not use the Euro symbol in an attachment name 
The Sametime service may be adversely affected if you attach a file with the Euro symbol (€) in the 
filename.  Do not use the Euro symbol in an attachment filename. 

Euro symbol may display incorrectly 
If a recorded meeting name contains the Euro symbol (€), the symbol may display incorrectly in the 
confirmation message users see when the delete a meeting. 

Workaround 
Enable UTF-8 in the Domino server document. 
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Linux: Square symbol may appear 
You may sometimes notice a misplaced, square-shaped symbol, for example in the Meeting Room Client. 

Workaround 
Using Traditional Chinese in the following example, perform these steps: 

1.	 Open the file ~/JAVA_HOME/lib/font.properties.zh_TW.Redhat. If you can see the string: 

filename.-arphic_technology_co.-ar_pl_mingti2l_big5-medium-r-normal--*-%d-* 
-*-c-*-iso10646-1=/usr/share/fonts/zh_TW/TrueType/bsmi00lp.ttf 

you need to add the file bsmi00lp.ttf to the path /usr/share/fonts/zh_TW/TrueType/ 

2.	 Copy /usr/share/fonts/zh_TW/TrueType/* in RedHat to the same path in SuSE.  If SuSE 
doesn't have this path, please create it. 

3.	 In ~/JAVA_HOME/lib/, input cp font.properties.zh_TW.Redhat 
font.properties.zh_TW 

4.	 In ~/mozilla/ , input export LANG=zh_TW LC_ALL=zh_TW , then input ./mozilla 

Macintosh: UIM may not show native UI for Norwegian locale 
The UIM Update Manager may not show the native UI for a Norwegian locale on the Macintosh. 

Workaround 
Add -Duser.language=no manually to the Sametime.INI file of the UIM installed folder, and it will display 
the Norwegian UI. 

Users may see incoherent message when ending a meeting 
If UTF-8 is not enabled for web publishing in the Domino server document, the confirmation message 
when a meeting has ended may display as garbled, or incoherent, text. 

Workaround 
Enable UTF-8 in the Domino server document. 

Meeting issues 

After setting Call Properties,  "Join the Call" may be disabled 
When joining a meeting that includes telephony, the user may need to enter the call properties before 
joining the call.  After entering the correct call properties, the "Join the Call" button may incorrectly remain 
disabled.  If the user leaves the meeting and rejoins, the "Join the Call" button is enabled. 
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Cannot edit Telephony-based meetings 
If you schedule a meeting that includes Telephony Options, you cannot later edit that meeting and remove 
the option. You can always add telephony to a scheduled meeting, but you cannot remove it once added. 

Workaround 
If you want to remove the telephony option from a scheduled meeting, delete the existing meeting and 
create a new meeting without telephony for the same time. 

Disk space limits for recorded meetings 
Using the Administration tool to set limits on when to stop recording meetings has no effect on 
roomservers.  No known workaround exists at this time. 

Do not import a nonexistent recorded meeting file 
When importing a nonexistent recorded meeting file during a Sametime meeting, the import may not 
function correctly. Avoid importing a nonexistent recorded meeting file. 

Do not use certain characters in a meeting name 
If the following characters are part of a meeting name, the meeting name may not display correctly, or 
users may be unable to attend the meeting successfully: 

\ (backslash) 
' ' (single quotes) 
& (ampersand) 
µ (mu) 

Do not use these characters in a meeting name. 

Do not use certain characters in a meeting password 
If the following characters are used within the password of a password-protected meeting, users may see 
an error in their browser. 

\ (backslash) 
ø (slashed o) 
æ (ae dipthong) 
å (a angstrom) 
µ (mu) 
€ (Euro symbol) 
£ (Pound symbol)

  Do not use these characters in your meeting password. 
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Do not use certain characters in password for recorded meeting

A Recorded Meeting may not playback correctly if you have used i18n (internationalized/localized) 

characters in the meeting password.  Do not use i18n characters in recorded meeting passwords.


Do not use double quotes in user name

Logging in as a LDAP user whose name contains double quotes (" ") will cause an error.  Do not use 

double quotes in a user's name.


Invited Servers - 7.0 to 7.5 whiteboard pointer discrepancies

With a Sametime 7.5 and Sametime 7.0 invited environment, there can be discrepancies in the

whiteboard tool's pointer icons.  In Sametime 7.5, the pointer tool was replaced by a new "stamp" tool.  

The previous whiteboard pointer tool allowed for selection from a variety of images; with Sametime 7.5, 

only one stamp image is available.


When a 7.0 user places various pointer images on the whiteboard, they will appear on the 7.5 whiteboard 

correctly, with the exception of the image of the "pointing finger"; this will appear as the stamp image

instead (a gold star).


Linux - Crash when using the IBM JVM 1.4.2 with Firefox

With certain configurations on Linux, using the IBM JVM 1.4.2 and the Firefox browser, the Meeting Room

Client can crash.


The Firefox help indicates that it is built with gcc3.2, and that any Java plug-in to be used with Firefox

must also be built with gcc3.2.  The standard libjavaplugin_oji.so that is linked to the Firefox

plug-ins directory is not built with gcc3.2 in IBM's distribution; you must link the

libjavaplugin_ojigcc3.so instead.


From the Firefox plug-ins directory, execute the following command:


ln -s /opt/IBMJava2-142/jre/bin/libjavaplugin_ojigcc3.so 
libjavaplugin_oji.so 

With this change, the Meeting Room Client loads successfully, and the browser will not crash. 
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Slides panel does not display text files 
Text files do not appear on the Slides panel during meetings, even when all other file types appear 
correctly. 

Workaround 

1.	 Delete the following two registry settings from the system running the Sametime Conversion Services 
(UNIX), or from the Sametime Server (Win32): 

z HKEY_LOCAL_MACHINE\Software\SCC\Viewer Technology\OEM5H 
z HKEY_CURRENT_USER\Software\SCC\Viewer Technology\OEM5H 

2.	 Restart Sametime and/or Conversion Services. 

3.	 Make sure the first file attached is not a text file. 

Some .SDD files cannot be converted and attached to a meeting 
In this release of Sametime, certain .SDD files are unable to be converted and added to a meeting.  This 
issue has been reproduced with StarOffice Impress and OpenOffice Impress .SDD files; this is a 
thrid-party software problem related to the Stellent filters in the Conversion Service. 

When this issue occurs, the user will not see any error messages. The only symptom is that the file will 
not show up on the Whiteboard; error messages are, however, printed in the logs. 

When changing the Chair, the old Chair may not be a presenter 
When the meeting Chair makes another user the Chair, the previous Chair may become a participant 
instead of a presenter. If the new Chair then gives the previous Chair permissions in the "Set 
Permisisons" dialog, then the previous Chair becomes a presenter. 

"In a meeting" status may not reset when a user leaves a meeting 
A user can set their preferences in the Meeting client to automatically or manually change their online 
status to "In a meeting" when they have joined a meeting or are sharing in a meeting.  If the user has 
done so, their online status may not automatically revert to "I am active" when they leave the meeting. 

The user can manually change their online status to "I am active" in the Meeting client. 
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Server issues 

AIX - Domino fails to connect to LDAP server with SSL via DA .nsf 
This issue is related specifically to Domino 7 on AIX.  The LDAP SSL works with the same steps on both 
Windows and Solaris when the "Verify server name with remote server's certificate" option is enabled.  It 
only works with Domino 6.5.1 on AIX. 

The workaround for the Domino server is to disable the "Verify server name with remote server's 
certificate" option in the DA.nsf database. 

Conversion Service and files with wrong extensions 

When file types have been renamed using a different (incorrect) extension, the conversion service will

attempt to convert the file with the incorrect extension.  This may result in the conversion service

producing a large number of incorrect converted images in the converted directory. These images will

eventually be cleaned up, but the process of creating the images may take a long period of time to

complete, in which the conversion service will appear non-responsive.  The process, however, will end.


Conversion Servlet: Servlet initialization errors on console

When Sametime 7.5 Conversion Services is installed as a Domino servlet, under certain conditions,

errors like the following may be printed to the Domino console:


Error occurred while initializing Servlet  (stconversion)

06/12/2006 04:48:45 PM  HTTP JVM:  -----Servlet Information----- Servlet name:

stconversion Servlet class : com.lotus.sametime.conversionservlet .ConversionServl

et Servlet state: <Error> Configuration parameters : SametimeDiagnostics .filepath

=SametimeDiagnostics_CS .properties

06/12/2006 04:48:45 PM  HTTP JVM: java.lang.NoClassDefFoundError : com/lotus/same

time/mime/MultiPartMimeFactory : com/lotus/sametime/mime/MultiPartMimeFactory


This problem usually occurs when Sametime 7.5 Conversion Services has been installed as a Domino 
servlet, uninstalled, and then reinstalled as a Domino a servlet.  This is because the Conversion Services 
uninstall fails to clean up servlets.properties.  As a workaround, after uninstalling Conversion Services, 
remove the stconversion servlet entries from the servlets.properties file (in the Domino data directory).  If 
servlets.properties contains entries ONLY for stconversion, then you may remove the servlets.properties 
file altogether.  Then reinstall Conversion Services as a Domino servlet, and the problem should no longer 
occur. 
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Enable\Disable policy regarding Auto Save chats 
The ability to automatically save chats on the client does not have a corresponding user interface on the 
administrator pages. The default is TRUE meaning, by default, all users who use 7.5 Connect will have 
their chats saved automatically. 

If the administrator wants to force a value for this attribute on some of the policies they have defined, they 
need to follow the below steps: 

Example - Auto Save the chat history attribute 

1. Open stpolicy.nsf 

2. Select the policy document that you want to update 

3. Switch to Edit Mode (double-click on the document form). 

4. Find the "Auto save chat history" attribute (ID = 2004) and update the attribute value. 

5. Update the Selector field value, if required: 

- If this is the default policy set, and the administrator wants to override this attribute in all users' 
policies, then the value of the "selector" field should be set to 2. 

- If this is a specific policy set, and the administrator wants automatically saved chats to inherit the 
value of the "Auto Save chat" attribute from the default policy, and to be affected from any change of 
the value on the default policy, then the value of the "selector" field should be set to 1. 

- The default value of the "selector" field is 0, which means that the value in the policy definition is the 
effective value. 

6. Save the document. 

7. Repeat steps 2-6 for all the policy documents that you want to update. 

8. Close stpolicy.nsf and restart the ST Policy service. 

On i5/OS (iSeries) some DBCS usernames may not log in correctly 
Using i5/OS (iSeries), a user with DBCS characters in the user name may not log in correctly. 

Workaround 
Run the "tell adminp process" command in from the Domino console.  Note that some DBCS user names 
are still not able to log in after running this command, for example, 王, 密密, 瞳. 

Policy Assign Users incorrectly says to select a directory 
The Policy Assign Users page incorrectly says to select a directory to add people / groups.  The Policy 
Assign Users applet searches all directories that are configured for Sametime. 

Policy Assign Users pages does not detect Java VM 
When accessing the Policy Assign Users page, a supported Java VM is required. The page does not 
correctly detect whether a supported JVM is installed. 
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Quick find behavior when Sametime server uses Domino LDAP 
The "quick find" option in UIM should be used differently if UIM is connected to a server that uses Domino 
LDAP. To find a name using the quick find option, type the whole name to get the requested result; 
typing only a few characters of the name is not enough. 

STReflector Service not listed in Admin Services overview list 
When you choose the "Administer the Server" link on a Sametime 7.5 server, you'll see a list of processes 
running on the server; the STReflector service is not listed there. 

To verify if the STReflector process is actually running on the server, go to the Windows task manager, 
and look for the "streflector.exe" task in the list.  If it is listed there, the service is running. 

You can also choose Administrative Tools -> Services from the Control Panel, and see the "ST Reflector" 
service listed there with the status "Started".  Similarly for UNIX, obtain the list of running processes on 
the server and verify that streflector is one of them. 

Telephony Services unavailable after upgrading service provider 
An Avaya Service Provider upgrade may fail in the following scenario: 

1) Start out with Sametime 7.0 + Telephony Toolkit + Avaya Service Provider 7.0 
2) Upgrade to Sametime 7.5 
3) Upgrade to Avaya Service Provider 7.5 

In this case, telephony services may fail to start.  A user may see an error message such as 
"Configuration Lookup Failed" when trying to start 
a meeting (meetings will continue to work correctly, but no telephony services will be available).  This 
occurs because the Sametime 7.5 upgrade 
overwrites some registry values that are needed for initializing telephony services.  When the telephony 
upgrade is performed, necessary actions will not be performed to restore these registry values. If you 
have a 7.0 Avaya Service Provider installed and wish to 
upgrade it, you must first uninstall the existing service provider.  If you wish to also upgrade from 
Sametime 7.0 to Sametime 7.5, you must install 
the new service provider after Sametime has been upgraded. 

The steps for upgrading from Sametime 7.0 + Avaya Service Provider 7.0 to Avaya Service Provider 7.5 
are below: 
1. Back up <Domino bin dir>/conference-adapter-configuration.xml and <Domino bin dir>/dial-plan.xml 
2. Uninstall the service provider
3. Upgrade to Sametime 7.5 
4. Install the new service provider
5. Reconfigure the service provider using your backups from (1) 

47 



IBM Lotus Sametime 7.5 Release Notes Known limitations, problems, and workarounds 

The steps for upgrading from Sametime 7.5 + Avaya Service Provider 7.0 to Avaya Service Provider 7.5 
are below: 
1. Back up <Domino bin dir>/conference-adapter-configuration.xml and <Domino bin dir>/dial-plan.xml 
2. Uninstall the service provider
3. Install the new service provider
4. Reconfigure the service provider using your backups from (1) 

Please be aware that configuration file formats between versions may change, so be careful when 
restoring backed-up configuration data.  To be safe, manually re-enter the configuration data using 
information from the backed-up files. 

See "Upgrading to Sametime 7.5 breaks Avaya Service Provider" in these release notes for more 
information. 

UNIX Mock Service Provider installed, but no telephony available 
The Telephony Mock Service Provider Unix install may not always be able to enable the telephony 
options in the Online Meeting Center.  In such a case, all the telephony components will be installed as 
normal, but will not be enabled.  This is an intermittent issue which seems to occur very infrequently.  If 
this occurs, perform the following manual steps to enable telephony: 

1. Stop the server.

2. Open the stconfig.nsf database in a Notes client. 

3. Open the MeetingServices document.

4. Change the fields "Audio Bridge Services" and "Telephony Services" to "true". 

5. Save and close the document. The telephony functions are now enabled. 

6. Restart the server. 

Upgrading to Sametime 7.5 breaks Avaya Service Provider 
Upgrading from Sametime 7.0 to Sametime 7.5 will cause an existing Avaya Telephony Service Provider 
to stop working. An error message will indicate that "Configuration lookup failed" for telephony services 
when scheduling a meeting.  This happens because the Sametime upgrade overwrites some registry 
values that are used to load the service provider.  An easy workaround is to back up your service provider 
configuration, uninstall the service provider, and then reinstall it.  If you have a 7.0 Avaya Service Provider 
installed and wish to upgrade to Sametime 7.5, perform the following steps: 

1. Back up <Domino bin dir>/conference-adapter-configuration.xml and <Domino bin dir>/dial-plan.xml 
2. Uninstall the service provider. 
3. Reinstall the service provider
4. Restore conference-adapter-configuration.xml and dial-plan.xml 

The key is to uninstall the existing service provider and then reinstall it (or install a newer version) after 
Sametime has been upgraded. Please be aware that, if you install a newer version of the service provider 
(or upgrade it), configuration file formats may have changed.  See "Telephony Services unavailable after 
upgrading service provider" in these release notes for more information. 
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"Policy search filters" link shown on policy list page 
The "Policy search filters" link is incorrectly shown on the policy list page when the Sametime server is 
configured using a Domino directory (name and address book).  This link should only be shown when the 
server is configured to use LDAP. 

Web conferencing issues 

Internet Explorer hangs when using Google Desktop Search

In certain cases, Internet Explorer will become unresponsive when attempting to attend a Web

Conference.  This issue occurs under the following circumstances:


z The Google Desktop Search is running 

z The Internet Explorer 6 browser is being used to attend the meeting 

z The Sun Java plug-in 1.5+ is being used as the JVM 

Workaround(s) 

1.	 Attend the meeting using another supported browser, such as the Mozilla 1.4.1+ browser (for 

Sametime 6.5.1), or the Netscape 7+ browser (for Sametime 3.1).


2.	 Use an older version of the Sun Java plug-in, such as 1.4.2_08. 

3.	 Uninstall the Google Desktop Search tool. 
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Chapter 4 - Documentation updates


Installing the Sametime server 

AIX / Solaris: Transfer files to the Sametime server 
In the topic "Managing Security for Sametime", when you are setting up the Domino HTTP server to 
support SSL 
for Solaris or AIX operating systems, the section that notes how to you transfer files to the server (the 
Domino server, not the Sametime server) lists four procedures required to use SSL to encrypt Web 
browser connections to a Sametime server that runs on the Solaris or AIX operating system.  In the 
second of these four procedures, you use FTP to transfer files from their current locations to the Domino 
server data directory; the updated procedure is shown here: 

z	 Use FTP to transfer the keyfile.kyr and keyfile.sth files from the data directory of your 
Notes client to the data directory of your Domino server (for example, the /local/notesdata 
directory). 

EMS clustering and anti-virus software installation 
The Help documentation topic "Installing anti-virus scanning (optional)" is listed under the wrong parent 
topic. Anti-virus software, if installed, should be done as a component of "Deploying the Enterprise 
Meeting Server", instead of as a component of "Installing the J2EE infrastructure on the EMS computer", 
because installing anti-virus software after installing the J2EE infrastructure will alter the sametime.ini 
file on the EMS server. 

EMS: Deploying the EAR files 
The procedure for deploying the EAR files while you are setting up the Enterprise Meeting Server and a 
meeting services cluster has changed.  The following steps correspond by number to the steps in the 
published Administrator's Guide.  To follow the corrected procedure, add in the steps shown in bold type, 
and delete the steps shown with strikethrough text. 

7. Check the box labeled, Generate Default Bindings . 

8. Select Override Existing Bindings. 

9. Check the radio button Use default virtual host name for Web modules. 

10. Click Next. 

11. At the Application Security Warnings page click Continue. 
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12. Click Next. 

12.a At the "Specify option for installing enterprise application and modules, " click Next. 

13. At Step 2: Map modules to servers: 

From the list, Select the server name (.ear file being installed) and webserver1 and check the 
boxes for STAdmin EJB and STAdmin WAR. Click Apply. 

14. Click Next. 

14.a  At the "Provide option to perform the EJB Deploy ",Select "DB2UDB_V82" in field Deploy EJB 
option -Database type, click Next . 

16. Click Next. 

17. Click Next. 

18. At Step 6: To map resource references to resources, select jdbc/SametimeDataSource. 

19. Select Node01/db2admin for the field of Use default method. 

20. Check the boxes of STServer EJB and STServer War. 

21. Click Next. 

22. Click Next. 

23. At Step 8: Map security roles to users/groups check the boxes for the following: 

stadmin

stmanager

stservices


24. Click Look up Users. 

25. In the Search String field, enter the WAS/EMS Admin username and click search. 

Enabling Telephony support 
When you install the Telephony Services on standalone Sametime Meeting Servers, Telephony is 
enabled by that action.  When adding these standalone servers to a Managed Meeting Cluster, you must 
enable Telephony so that the UI components show up, which allows users to add Telephony to their 
meetings. 

To do this, you will need to update the value for AUDIOBRIDGEENABLED in the 
STCONFIG.ORGANIZATION table in DB2 from "false" to "true".  To do this: 

From a db2 command window, issue the following commnands: 

z Connect to Sametime 
z Update stconfig.organization; set AUDIOBRIDGEENABLED to "true' and click Enter 
z Disconnect from Sametime 
z Restart the Enterprise Meeting Server and roomservers 

Form of name added to Access Control List  (ACL)

With the stconfig.nsf database open, navigate to File -> Database -> Access Control; click Add.  In 

the "Add User" dialog box, manually add the WAS/EMS Admin name in the following form:


sametime admin/Lexington/ibm/us 
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Setting up the EMS and a Meeting Service Cluster

It is possible to select HTTP tunneling on port 80 for Sametime clients -- there is no reason not to select

this option, if desired.  The Sametime server installation provides an option to enable HTTP tunneling on

port 80 for Sametime clients.


Reference text: Do not select this option during the Sametime server installation. A Sametime server 

attached to the EMS should not be configured to support HTTP tunneling on port 80.


Administering the Sametime server 

Assigning policies to groups

You can assign a standard policy to a group, for example, Marketing.  On the 'Setting new Policy for

groups' page, create a new Policy named "policyMarketing", assign users to policyMarketing, and View

the details of policyMarketing. To do this, follow these steps:


1.	 On the main Policy page, click "New". 

2.	 Fill in the name of the Policy. 

3.	 Add a description for the Group/Policy. The default size of the text entry field is a maximum of 200 

characters.


4.	 Select the policy attributes you want to update and click "OK," or click "Cancel" to cancel all new

policy settings for the group.


5.	 Click "Assign Users". 

6.	 On the 'Assign Users' page, select a directory to add users and groups.  Search or type the user or 
group names to find them, and add them to the policy.  Add as many names and groups to the list as 
needed. 

7.	 Select "OK" to return to the policy list page. 

8.	 To delete the Group/Policy settings, click "Delete". 

Note:  Users/groups can be assigned to a user policy.  The default policy has no user/group assignment.  
When the Sametime Policy service calculates a policy for a specific user, it applies the default policy if no 
other policy is found for that user. 

Client log file overview

By default, all generated metadata files, including log files, are located in <user.home>/Application

Data/Sametime, for example on windows, C:\Documents and Settings\<username>\Application

Data\Sametime.


1) <user.home>/Application Data/Sametime/sametime.log.{x}

The Sametime application log file.  Contains all log statements and exceptions handled by the Sametime

client. 


The numbers at the end of the log file are increased everytime a new client session is started.  The active 
client session is always sametime.log.0, the previous session becomes sametime.log.1, the one before 
that becomes sametime.log.2, etc. 
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2) <user.home>/Application Data/Sametime/.metadata/.log 
The WED platform log file.  Contains log statements and exceptions handled by the WED platform. 

Consult the ".log" file whenever the following dialog is shown: 

This dialog is a WED dialog and typically means that an uncaught exception has occured, and "fallen

through" to the platform.  


3) <user.home>/Application Data/Sametime/sametimeLaunch.log

Sametime log file created for the initial application launch before the application log is initialized.  It is

typically not needed in a problem report unless the problem is related to launching the application.


Configuring a photo for the Business Card

To configure and store photos for the Business Card:


This service can retrieve photos that have been added to the directory. As with any attribute, the mapping 
of the photo field can be changed with the Administrator's Tool. 

Photos in the LDAP directory 
Store photos in the LDAP jPegPhoto  standard attribute; an entry in a LDAP directory has this attribute if 
its objectclass is inetOrgPerson. This attribute is set by default as the field name mapped to the 
Photo detail in a Sametime server configured with LDAP. 

Supported file types for retrieval from LDAP directory : jpeg 

Note: Storing and retrieving photos from Domino LDAP requires additional steps.  Please refer to the

Administrator's Guide section "Configuring photos in Domino LDAP".


Photos in a Domino directory

To retrieve photos from the Name and Address Book, follow these steps:


1. Add a "Rich Text" or "Rich Text Lite" field to the Person form of the Name and Address Book. 

Two methods are available for storing photos in the newly-added rich text field: 

z Import - Click on the rich text field and choose Create->Picture; this adds the file content to the field 

z Attach - Save the image file in the rich text field as an attachment 

1.	 With the Administration tool, go to the Business Card Attribute page.  In the text box for Photo

Mapping, type the name of the rich text field that you added to the Name and Address Book above,

matching the case, then click Update.


2. Restart the Domino server 

Supported file types for retrieval from Domino directory : .jpeg, gif. 

This information and additional information is located in a Tech Note at: 

http://www-1.ibm.com/support/docview.wss?rs=899&uid=swg21176248 
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Editing the Sametime.ini file (EMS and Meeting Services Cluster ) 
The method for editing the Sametime.ini file while adding a new server has changed.  This topic is located 
inthe Help documentation under "Setting up the Enterprise Meeting Server and a Meeting Services 
cluster" -> "EMS deployment and Meeting Services cluster setup procedures" -> "Adding Sametime 
servers to the EMS" -> "Adding a Sametime server using the EMS Administration Tool ": 

Edit the Sametime.ini file

 1. On the Room Server (1or2), navigate to C:\Lotus\domino\ and open the sametime.ini file in Notepad.  

2. At the end of the [Config] section of the document, add the following lines (case-sensitive): 

SametimeAdminUsername= enter the WAS/EMS Admin username (for example, sametime

admin)

SametimeAdminPassword= enter the WAS/EMS Admin password (for example, sametime)


3. Make sure STAdmin, STServer, STCenter on EMS Server running. 
4. Re-start the Sametime server you have just added to the Meeting Services cluster. 
5. Repeat this procedure for each Sametime server you want to add to the EMS. 

EMS and Meeting services cluster  - Meeting services document 
The following text in the Administrator's Guide is incorrect: 

Add the LDAP directory account user name (for example "Meeting Management Access") to the ACL 
of the Configuration database (stconfig.nsf) on the Sametime server.  Provide this user name with the 
Manager access level. Also, assign all available Roles in the stconfig.nsf database ACL to the user 
name. 

When you add a user from the LDAP directory to the Access Control List in the Meeting Services 
document, the user's name should be entered in this format: sametime admin/anysite/company/us 

To add a name from LDAP, keep the stconfig.nsf database open, then navigate to File - Database - 
Access Control. Click Add; add the name in the format above. 

File transfer capabilities 
In Logging File Transfer events, the log event information includes: file name, the sender's user ID, the 
receiver's user ID, the size of the file, the status of the operation -success/failure- reason code, and the 
reason string. 

Use the Policies menu item in Sametime Administration to configure file transfer capabilities for users.  
You can modify an existing policy or create a new policy. 

LTPA token authentication 
The following release note applies to Community Services, allowing the user to authenticate: 

If the Sametime client sends a lightweight third-party authentication (LTPA) token with the organization 
parameter set to "null", the user will fail to log into the server.  Instead, send the token with the 
organization parameter as defined in the ST_ORG_NAME flag of the Notes.INI file.  This parameter 
should contain the organization name as defined in the Web Single Sign-On (SSO) document. 

After you add the organization name to the SSO document, and add the flag ST_ORG_NAME=<name of 
organization of Web site that appears in Web SSO document>, then restart the server, the user can then 
input the UserID and password to log in. 
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Name change task: 'All servers'

The 'All servers' option on the Name change task page in the Administration tool does not work because

of the 

procedure for replicating across all servers. If you create a name change task and select 'All servers,' 

only the server you are logged on to contains the task--other servers do not.  This is viewable in

stnamechange.nsf through the Notes client.


The correct procedure is to create the name change task on all the servers in the community. 

Preparing to run a Name Change task

The following instruction for step number 2 should be replaced with the information in step 2R; step 

number 4R replaces step number 4:       


2.	 Automatic scheduling for name Change utility - optional. You can decide for each cluster which 
server will be used as the server that runs Name Change utility. After choosing the server, you can 
use the standard operating system scheduling mechanism to set up an automatic run for this utility. 

2R:  Create a name change task with the Administrator's Tool .  Name change tasks are then logged in to 
stnamechange.nsf.  

3.	 NameConversion.csv and VPUserInfo.nsf should be located in the Domino - Data folder. 

4.	 The csv file must be named NameConversion.csv. 

4R.	 The csv file must include the file extension  .csv, but may be given any name . 

Running the Name Change Task 
z	 When running a Name Change task, the administrator must run it manually, and not automatically by 

a scheduler as stated in the Administrator's Guide for Sametime 7.5. 

Referenced text:  You choose the servers of each Sametime cluster on which the Name Change 
application runs. The application does not run by default. The administrator has to run it manually, or 
automatically, by a scheduler in case you want to run it on a regular basis (i.e once a week on Sunday 
night) 

z	 In the topic 'Changing names on distributed servers,' the name changes are done manually. 

Referenced text: The administrator is responsible to choose the servers of each Sametime cluster on 
which the Name Change application run. The application is not running by default. You can run it 
manually, or automatically, by a scheduler in case you want to run it on a regular basis (such as once 
a week on Sunday night) . 
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Setting up a LDAP connection after selecting Domino directory 
When copying and renaming the .DLL files, and editing the Notes.ini file or the Sametime.ini file after 
creating an LDAP document in the Configuration database, the paths for the .DLL files have changed. 

Copy and rename the  .DLL files, edit the Notes .ini file, or edit the Sametime .ini file 
This procedure is the sixth of nine associated with enabling Sametime to connect to an LDAP server if you 
have selected the Domino directory during the server installation. 

The procedure you perform at this point depends on whether your Sametime server runs on the Windows, 
AIX/Solaris, or IBM i5/OS operating system. 

z	 If your Sametime server runs on the Windows operating system, you must copy and rename some 
.DLL files from the C:\Program Files\Lotus\Domino\Directory BB\Ldap (this is the 
default directory where Domino is installed)  or $installedDIR\Lotus\Domino\Directory
BB\Ldap directory to the C:\Program Files\Lotus\Domino or 
$installeddir\Lotus\Domino directory. 

z	 If your Sametime server runs on the AIX/Solaris operating system, you must edit the Sametime.ini

file.


z If your Sametime server runs on the IBM i5/OS operating system, you must edit the Notes.ini file. 

Follow the procedure below that is appropriate for your environment. 

Copying and renaming the DLL files  (Windows only)


If your Sametime server runs on the Windows operating system, perform this procedure:


 1.	 On the Sametime server, create a working directory to copy files to so that you can rename them.

 2.	 Copy the "STAuthenticationLdap.dll" from the directory  C:\Program
Files\Lotus\Domino\Directory BB\Ldap (this is the default directory where Domino is 
installed)  or $installedDIR\Lotus\Domino\Directory BB\Ldap to the working directory.

 3.	 In the working directory, rename the "STAuthenticationLdap.dll" file to "STAuthentication.dll."

 4.	 Copy the renamed "STAuthentication.dll" file to the C:\Program Files\Lotus\Domino or 

$installeddir\Lotus\Domino directory.


Note  Copying the "STAuthentication.dll" file to the C:\Program Files\Lotus\Domino or 
$installeddir\Lotus\Domino directory will overwrite an existing file of the same name. 

5.	 Copy the file "STGroupsLdap.dll" from the directory C:\Program
Files\Lotus\Domino\Directory BB\Ldap (this is the default directory where Domino is 
installed)  or $installedDIR\Lotus\Domino\Directory BB\Ldap to the working directory.

 6.	 Rename the "STGroupsLdap.dll" file to "STGroups.dll."

 7.	 Copy the renamed STGroups.dll file to the C:\Program Files\Lotus\Domino or

$installeddir\Lotus\Domino .


Note  Copying the "STGroups.dll" file to the C:\Program Files\Lotus\Domino or

$installeddir\Lotus\Domino will overwrite an existing file of the same name.


 8.	 Copy the file "STResolveLdap.dll" from the directory C:\Program

Files\Lotus\Domino\Directory BB\Ldap to the working directory.


 9.	 Rename the "STResolveLdap.dll" file to "STResolve.dll." 
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10.	 Copy the renamed "STResolve.dll" file to the C:\Program Files\Lotus\Domino or

$installeddir\Lotus\Domino.


Note  Copying the "STResolve.dll" file to the C:\Program Files\Lotus\Domino or 

$installeddir\Lotus\Domino  will overwrite an existing file of the same name.


 11.	 Copy the "StBrowseLdap.dll" file from the directory C:\Program
Files\Lotus\Domino\Directory BB\Ldap (this is the default dir where Domino is installed)  
or $installedDIR\Lotus\Domino\Directory BB\Ldap to the working directory.

 12.	 Rename the "StBrowseLdap.dll" file to "StBrowse.dll."

 13.	 Copy the renamed STBrowse.dll file to the C:\Program Files\Lotus\Domino or

$installeddir\Lotus\Domino.


Add these steps to this procedure

 14. Copy the "StDirectoryListLDAP.sym" file from the directory  C:\Program 
Files\Lotus\Domino\Directory BB\Ldap (this is the default dir where Domino is installed)  or 
$installedDIR\Lotus\Domino\Directory BB\Ldap to the working directory.

 15.	 Rename the "StDirectoryListLDAP.sym" file to "StDirectoryList.sym."

 16.	 Copy the renamed StDirectoryList.sym file to the C:\Program Files\Lotus\Domino or 

$installeddir\Lotus\Domino


 17.	 Copy the "StLdap.dll" file from the directory  C:\Program Files\Lotus\Domino\Directory BB\Ldap (this 
is the default dir where Domino is installed)  or $installedDIR\Lotus\Domino\Directory BB\Ldap to  
C:\Program Files\Lotus\Domino or $installeddir\Lotus\Domino

 18.	 Copy the "stLdap.ini" file from the directory  C:\Program Files\Lotus\Domino\Directory BB\Ldap (this 
is the default dir where Domino is installed)  or $installedDIR\Lotus\Domino\Directory BB\Ldap to  
C:\Program Files\Lotus\Domino or $installeddir\Lotus\Domino 

Editing the Sametime.ini file (AIX/Solaris only) 
If your Sametime server runs on the AIX/Solaris operating system, perform this procedure to edit the 
Sametime.ini file in the Sametime server installation directory. You must change the DirectoryType 
parameter from "Domino" to "LDAP" in the Sametime.ini file.

 1. Use a text editor to open the Sametime.ini file located in the Sametime server installation directory 
(for example, <root>/lotus/domino).

 2. In the [CONFIG] section of the Sametime.ini file edit the DirectoryType= parameter so that it 
specifes LDAP as shown below: 

DirectoryType=LDAP  

3. Save and close the Sametime.ini file. 

Editing the Sametime.ini file (IBM i5/OS only) 

If your Sametime server runs on the IBM i5/OS operating system, perform this procedure to change the 
DirectoryType parameter from "Domino" to "LDAP" in the sametime.ini file: 

1.	 Use a text editor to open the sametime.ini file located in the Sametime server data directory

 2.	 In the [Directory] section of the sametime.ini file edit the DirectoryType= parameter so that it 
specifes LDAP as shown below: 

DirectoryType=LDAP

 3.	 Save and close the sametime.ini file. 
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Setting up SSL for i5/OS Sametime servers 
If you are planning to set up SSL to encrypt browser connections to an i5/OS Sametime server, please 
see technote 1216566, "Sametime for i5/OS: Setting up SSL to encrypt browser connections", for 
instructions. This technote is available at: 

http://www.ibm.com/support/docview.wss?rs=203&uid=swg21216566 

Solaris: Using LDAP directories with Sametime 
In the topic "Installing IKeyMan on the AIX/Solaris server", please note that there is no jre directory 
under the ibm-jre directory on Solaris: 

1. On Solaris:

Open the java.security file located at

/opt/ibm/lotus/notes/latest/sunspa/ibm-jre/jre/lib/security/java.security


should read 
/opt/ibm/lotus/notes/latest/sunspa/ibm-jre/lib/security/java.security 

2. On Solaris: 
Delete gskikm.jar from this location: 
/opt/ibm/lotus/notes/latest/sunspa/ibm-jre/jre/lib/ext 

should read 
/opt/ibm/lotus/notes/latest/sunspa/ibm-jre/lib/ext 

3. On Solaris: 
JAVA_HOME=/opt/ibm/lotus/notes/latest/sunspa/ibm-jre/jre export JAVA_HOME 

should read 
JAVA_HOME=/opt/ibm/lotus/notes/latest/sunspa/ibm-jre 

Update - Policy table 
Please replace the following table fragment in the documentation: 

Use excluded file types 
list

 Yes  No  Yes 

Use excluded file types 
list 

Yes Yes Yes 

Excluded File Types  exe  -­ exe (union) 

Excluded File Types  exe  gif, jpg, png, bmp  exe, gif, jpg, png, bmp 
(union) 
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with this fragment: 

Use excluded file types 
list

 Yes  No  Yes 

Excluded File Types  exe  -­ exe (union) 

Use excluded file types 
list 

Yes Yes Yes 

Excluded File Types  exe  gif, jpg, png, bmp  exe, gif, jpg, png, bmp 
(union) 

Using SSL to encrypt connections between ST servlet and LDAP 
When using SSL to encrypt connections between the Sametime servlet and LDAP, a jks key store 
containing the LDAP SSL Certificate Authority must be created.  The term 'kdb' should be replaced with 
the term 'jks'. 

There are two ways to create a jks key store.  Create a new jks key store using IKeyMan, and import 
the LDAP SSL Root CA and LDAP SSL server certificate into this jks key store.  To create a jks key 
store usting IKeyMan, refer to the sections "Use IKeyMan to create a key store file on the Sametime 
server (Windows only)" and "Use IKeyMan to create a key store file on the server (Solaris/AIX)" in the 
Administrator's Guide for additional information. 

Instructions for Windows 

1.	 Run the command to convert a kdb (CMS) file to a jks file (from the GSKit installation folder): 

gsk6cmd.exe -keydb -convert -db key.kdb -pw <password> -old_format cms 
-new_format JKS 

2.	 Convert an existing kdb key store containing the LDAP SSL Certificate Authority to jks format key 
store 

3.	 Update UserInfoConfig.xml with the LDAP server's SSL information: 

a.	 Open UserInfoConfig.xml located in the Sametime server program directory

(C:\Lotus\Domino\UserInfoConfig.xml) in a text editor.


b.	 In the tag <SslProperties>, set the following: 

KeyStorePath="C:\Lotus\Domino\key.jks" (KeyStorePath should be the full path to 
key.jks created in Step 1) 
KeyStorePassword="password" (KeyStorePassword should be the password to key.jks
created in Step 1) 

After the KeyStorePath and KeyStorePassword values have been added to UserInfoConfig.xml, restart 
the HTTP service. 
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Instructions For AIX / Solaris 

1.	 Run the command to convert a kdb (CMS) file to a jks file: 

gsk6cmd -keydb -convert -db key.kdb -pw <password> -old_format cms 
-new_format JKS 

2.	 Update UserInfoConfig.xml with the LDAP server's SSL information: 

a.	 Open UserInfoConfig.xml located in the Sametime server program directory

(C:\Lotus\Domino\UserInfoConfig.xml) in a text editor.


b.	 Note:  for AIX / Solaris, UserInfoConfig.xml is located in the Sametime server data directory 

c.	 In the tag <SslProperties>, set the following: 

KeyStorePath="C:\Lotus\Domino\key.jks" (KeyStorePath should be the full path to 
key.jks created in Step 1) 
KeyStorePassword="password" (KeyStorePassword should be the password to key.jks
created in Step 1) 

After the KeyStorePath and KeyStorePassword values have been added to UserInfoConfig.xml, restart 
the HTTP service. 

Instructions for i 5/OS 

1.	 Import the SSL Trusted Root certificate for your LDAP server into the stkeys.jks file in the 
Sametime server data directory. Refer to the section "Importing the SSL certificate on an i5/OS 
system" in sthelpad.nsf for additional information on this task. 

2.	 Update UserInfoConfig.xml with the LDAP server's SSL information: 

a.	 Open UserInfoConfig.xml (located in the Sametime server data directory) in a text editor. 

b.	 In the tag <StorageDetails> set the following: 

SslEnabled="true" and SslPort="636" (this should be the SSL port that your LDAP 
server listens on) 

c.	 In the tag <SslProperties>, set the following: 

KeyStorePath="stkeys.jks" (use your keystore name, do not include any path 
qualifiers); KeyStorePassword="sametime" (use your keystore password). 

After the KeyStorePath and KeyStorePassword values have been added to UserInfoConfig.xml, restart 
the HTTP service. 
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Sametime Connect Client end -user Help 

Sametime Connect Client end-user Help updates/corrections

The following list identifies corrections and other information related to the IBM(R) Lotus(R) Sametime

Connect Client end-user Help:


z	 In the Help topic, "Repeating scheduled meetings," Step 5 refers to a section of the user interface 
called "Exceptions." This section does not appear in the implemented user interface. 

z	 The Help topic, "Managing a telephone conference call," refers to the Lock the Call/Unlock the Call 
feature. This feature is not available. 

z	 In the Help topic, "Setting chat window preferences," Step 12 refers to the setting, "Check my spelling 
as I type in the message field."  This setting is actually available by clicking File - Preferences - Spell 
Checking and is implemented as, "Always check my spelling as I type in the message field".

z	  In the Help topic, "Setting chat history preferences," Step 8 is not available in the user interface. The 
recorded voice chats feature is not available. 

z	 The Help topics, "Participating in a voice chat" and "Managing a voice chat" mention voice chat 
recording options. Voice chat recording is not available. 

z	 The Help topic, "Participating in a voice chat," mentions a speaking icon that displays beside a 
participant who is talking. This icon does not display. 

z	 The Help topics, "Starting a voice chat from the Contact list" and "Converting a text chat to a voice 
chat," mention that by default, up to five people, including the moderator, can participate in a voice 
chat although the system administrator can adjust this limit. In fact, different implementations can 
have different limitations on the number of voice chat participants. 

z	 The Lotus Sametime Connect Help includes a topic, "Resuming a chat from a saved chat transcript." 
This feature is not available. 

z	 The Help topic, "Managing a telephone conference call," refers to various actions that a moderator 
can take on all participants at once or on individual participants, including Lock the call/Unlock the 
Call, Associate my phone, and Hang up my phone, Call User At, Volume, Rename, and Associate.  
These latter actions are not available in this release. In addition,  the Mute User action actually 
"silences" the participant. This  means that the participant cannot "unmute/unsilence" themselves; 
only the moderator can remove the silence. Finally, this Help topic refers to "Show Call-in Number." 
This should be "Call-in Number." "Hang up user" should be "Disconnect user." 

z	 The Help topic, "Participating in a telephone conference call," refers to controls for participating in a 
telephone conference call, including Associate. This control is not available. In addition, participants 
do not have controls next to other individual's names in the participant list. 

z	 At the bottom of the Help topic, "Logging in," the Related Tasks link "Starting Automatically" is not 
available. 

z	 At the bottom of the Help topic, "Moving contacts," the Related Tasks link "Moving groups" is not 
available. 

z	 At the bottom of the Help topic, "Changing your availability status," the first two Related Tasks links 
should read, "Automatically changing your availability status" and "Setting availability status message 
preferences," respectively. 

z	 At the bottom of the Help topic, "Changing your availability status," the Related Tasks link should 
read, "Editing your current availability status message." 

z	 At the bottom of the Help topic,  "Participating in a voice chat," the Related Tasks link "Playing back a 
recorded voice chat" does not work.  The recorded voice chat feature is not available. 
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Web conference/Meeting end-user Help updates/corrections

The following list identifies corrections and other information related to the IBM(R) Lotus(R) Sametime

Web Conference (Meeting) end-user Help:


z	 When viewing Web conferencing (Meeting) Help, some text may display as linked (underlined) text, 
although it is not actually a link. 

z	 The Help topics "Choosing a Meeting Chair" and "Choosing Participants for a Meeting" incorrectly 
mention the ability to browse one or more directories to look for names.  Instead, you search for 
names. 

z	 The Help topic "Shortcut Keys" incorrectly identifies CTRL + X as the shortcut key for copying in the 
Meeting Room and Playback clients (for recorded meetings). CTRL + X is the shortcut key for cutting 
text. 

z	 The Help topic, "Viewing and Attending a  Scheduled Meeting (without Search) refers to two Meeting 
Center views that are not available in an Enterprise Meeting Server (EMS) environment: Unlisted 
Meetings and View by Calendar. 

z	 The Help topic, "Slides: Adding Slides to Display," identifies some incorrect information about the 
slide types that are automatically converted. The corrections follow: 

z	 OpenOffice Calc, versions 1.1, 2.0 (text , SDC) 
z	 OpenOffice Impress, versions 1.1, 2.0 (text, SDD) 
z	 OpenOffice Writer, versions 1.1, 2.0 (text, SXW) 
z	 StarOffice Calc versions 5.2, 6.x, 7.x, and 8.0 (text only) 
z	 StarOffice Impress 5.2, 6.x, 7.x and 8.0 (text only) 
z	 StarOffice Writer 5.2, 6.x, 7.x and 8.0 (text only) 

z	 The Help topics, "Allowing Others to Control the Shared Screen," "Ensuring Security," and "Using the 
Screen-Sharing Tools," refer to the "Allow Control" button. This button allows others to control your 
screen during screen sharing. These topics also refer to the "Reclaim control" button. This button 
allows you to reclaim control of your screen. 

z	 The Help topic, "Importing(Saving) a Recording of a Meeting," refers to "Secure this meeting by not 
listing it in the Meeting Center." This should be "Do not list this meeting (people must attend it with the 
URL or by searching for it by name)". 

z	 The Help topic, "Handling Permissions," refers to "Remove Permissons to All." This should be 
"Revoke Permissions for All". 

z	 The Help topic, "Monitoring the Length of the Meeting," refers to "Edit - Change Meeting Duration." 
This should be "Edit - Editing Meeting Information". 

z	 The Help topic, "Options: Setting Meeting Options" refers to the check box, "People can attend from 
multiple external Sametime servers." This should be "People can attend from external Sametime 
servers". 

z	 The Help topic, "Repeating the Meeting" refers to the "How often the meeting repeats" field. This field 
does not appear in the user interface. Just select how often you want to repeat the meeting.  This 
topic also refers to the "Starting" field; this should be "Starting date". 

z	 The Help topic, "Shortcut Keys" refers to "Tools - Sharing - Let Other Control." This should be "Tools - 
Let Others Control My Screen". 

z	 The Help topic, "Starting a Breakout Session" refers to the "New Breakout" menu command and 
action bar icon. This should be "New Breakout Session". 
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z	 The Help topic, "Tips for Arranging the Meeting Room" refers to "Sidebar tools." This should be 
"Sidebar tabs." In addition, this topic refers to clicking "Back to Standard View" in the floating window. 
This should be "Back to Meeting Room". 

z	 The Help topic, "Why Is the Image in the Speaker's Video Window an IBM Lotus Sametime Logo?" 
refers to the "Play video" button. This should be "Play". 

z	 The Help topic, "Viewing Poll Responses Shared by the Chair" refers to the "Poll Tab." This should be 
"Polling". 

z	 The Help topic, "Viewing the Participant Who Is Speaking" refers to clicking "Pause Video." This 
should be "Pause". 

z	 The Help topic, "Accessing Meeting Details," refers to the "Expected connections" field. This should 
be "Expected participants". 

z	 The Help topic, "Recording the Meeting" refers to some functionality not available on the Enterprise 
Meeting Server (EMS) version of Web conferencing, including links to exporting (saving) a recorded 
meeting, replacing a recorded meeting with another meeting, and importing (saving) a recording 
meeting. 
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Chapter 5 - Notices and trademarks


Notices 
This information was developed for products and services offered in the USA. IBM may not offer the 
products, services, or features discussed in this document in all countries. Consult your local IBM 
representative for information on the products and services currently available in your area. Any reference 
to an IBM product, program, or service is not intended to state or imply that only that IBM product, 
program, or service may be used. Any functionally equivalent product, program, or service that does not 
infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to 
evaluate and verify the operation of any non-IBM product, program, or service. 

IBM may have patents or pending patent applications covering subject matter described in this document. 
The furnishing of this document does not give you any license to these patents. You can send license 
inquiries, in writing, to: 

IBM Director of Licensing 
IBM Corporation 
North Castle Drive 
Armonk, NY 10504-1785 
U.S.A. 

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property 
Department in your country/region or send inquiries, in writing, to: 

IBM World Trade Asia Corporation Licensing 
2-31 Roppongi 3-chome, Minato-ku 
Tokyo 106, Japan 

The following paragraph does not apply to the United Kingdom or any other country/region where such 
provisions are inconsistent with local law: 

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" 
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY, OR 
FITNESS FOR A PARTICULAR PURPOSE. 

Some states do not allow disclaimer of express or implied warranties in certain transactions; therefore, 
this statement may not apply to you. 

This information could include technical inaccuracies or typographical errors. Changes are periodically 
made to the information herein; these changes will be incorporated in new editions of the publication. IBM 
may make improvements and/or changes in the product(s) and/or the program(s) described in this 
publication at any time without notice. 

Any references in this information to non-IBM Web sites are provided for convenience only and do not in 
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part 
of the materials for this IBM product, and use of those Web sites is at your own risk. 

IBM may use or distribute any of the information you supply in any way it believes appropriate without 
incurring any obligation to you. 
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Licensees of this program who wish to have information about it for the purpose of enabling: (i) the 
exchange of information between independently created programs and other programs (including this 
one) and (ii) the mutual use of the information that has been exchanged, should contact: 

Lotus Software 
IBM Software Group 
One Rogers Street 
Cambridge, MA 02142 
USA 

Such information may be available, subject to appropriate terms and conditions, including in some cases 
payment of a fee. 

The licensed program described in this document and all licensed material available for it are provided by 
IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement, or by 
any equivalent agreement between us. 

Any performance data contained herein was determined in a controlled environment. Therefore, the 
results obtained in other operating environments may vary significantly. Some measurements may have 
been made on development-level systems, and there is no guarantee that these measurements will be 
the same on generally available systems.  Furthermore, some measurements may have been estimated 
through extrapolation. Actual results may vary. Users of this document should verify the applicable data 
for their specific environment. 

Information concerning non-IBM products was obtained from the suppliers of those products, their 
published announcements, or other publicly available sources. IBM has not tested those products and 
cannot confirm the accuracy of performance, compatibility, or any other claims related to non-IBM 
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of 
those products. 

All statements regarding IBM's future direction or intent are subject to change or withdrawal without 
notice, and represent goals and objectives only. 

This information contains examples of data and reports used in daily business operations. To illustrate 
them as completely as possible, the examples include the names of individuals, companies, brands, and 
products.  All of these names are fictitious and any similarity to the names and addresses used by an 
actual business enterprise is entirely coincidental. 
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Trademarks 
IBM, the IBM logo, AIX, DB2, Domino, i5/OS, Lotus, Lotus Notes, LotusScript, Notes, Sametime, 
WebSphere, and z/OS are trademarks or registered trademarks of IBM Corporation in the United States, 
other countries, or both. 

Additional IBM copyright information can be found at: http://www.ibm.com/legal/copytrade.shtml 

Microsoft, Windows, and the Windows logo are trademarks of Microsoft Corporation in the United States, 
other countries, or both. 

UNIX is a registered trademark of The Open Group in the United States and other countries. 

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun 
Microsystems, Inc. in the United States, other countries, or both. 

Intel and Pentium are trademarks of Intel Corporation in the United States, other countries, or both. 

Other company, product, or service names may be trademarks or service marks of others. 
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